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Kurzzusammenfassung
Diese Bachelorarbeit untersucht die Hochfrequenzsoftware AWR Microwave O�ce in Bezug
auf ihre Eignung zur Lösung elektromagnetischer Feldprobleme. Das Hauptziel der Arbeit
ist es, die Möglichkeiten und Grenzen der Software für die Feldproblemlösung aufzuzeigen.
Hierzu werden verschiedene Einstellmöglichkeiten der Software detailliert betrachtet und
auf wichtige Parameter und ihre Auswirkungen auf die Simulationsergebnisse eingegangen.
Zentraler Bestandteil der Arbeit ist der Design- und Simulationsprozess einer Patchantenne, der
als Fallbeispiel dient, um typische Vorgehensweisen und Herausforderungen bei der Nutzung
dieser Software zu veranschaulichen. Darüber hinaus werden die Simulationsergebnisse mit
einem physischen Nachbau der Antenne verglichen, um die Genauigkeit der Software zu
bewerten. Die Ergebnisse zeigen, dass AWR Microwave O�ce hohe Genauigkeit bei der
Lösung elektromagnetischer Feldprobleme erreichen kann, allerdings mit Herausforderungen
bezüglich der Meshkon�guration und der Rechenzeit konfrontiert ist. Es wird festgestellt, dass
auch scheinbar unbedeutende Parameter einen erheblichen Ein�uss auf die Genauigkeit und
E�zienz der Simulation haben können.
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Abstract
This bachelor thesis examines the high-frequency software AWR Microwave O�ce in terms
of its suitability for solving electromagnetic �eld problems. The main goal of the work is to
highlight the capabilities and limitations of the software for �eld problem solving. To this
end, various software con�guration options are examined in detail, and key parameters and
their e�ects on the simulation results are discussed. A central part of the work is the design
and simulation process of a patch antenna, which serves as a case study to illustrate typical
procedures and challenges in using this software. Additionally, the simulation results are
compared with a physical replica of the antenna to assess the accuracy of the software. The
results show that AWR Microwave O�ce can achieve high accuracy in solving electromagnetic
�eld problems but faces challenges regarding mesh con�guration and computation time. It is
observed that even seemingly insigni�cant parameters can have a signi�cant impact on the
accuracy and e�ciency of the simulation.
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1 Einführung

1.1 Definitionen

Mesh
Ein Mesh in dem Kontext der Simulation bezieht sich auf ein Gitternetz, das über ein Simu-
lationsgebiet gelegt wird, um dieses zu diskretisieren. Dieses Netz dient dazu, Strukturen in
kleinere, handhabbare Elemente zu zerlegen.

Solver
Ein Solver ist ein algorithmisches Werkzeug oder eine Softwarekomponente, die zur Lösung
von mathematischen Problemen eingesetzt wird. In dem Kontext der Simulation, insbesondere
in der elektromagnetischen Feldsimulation, bezieht sich der Begri� auf die Algorithmen und
Methoden, die verwendet werden, um die Gleichungen zu lösen, die das physikalische Verhal-
ten des simulierten Systems beschreiben.

EM Struktur
In AWR Microwave O�ce beschreibt die EM Struktur ein volumetrisches Objekt, welches auf
seine elektrischen Eigenschaften geprüft wird. Die Simulation wird zur Lösung des Feldpro-
blems auf eine solche Struktur angewandt.

CAD
CAD (Computer-Aided Design) bezeichnet den computergestützten Prozess des technischen
Entwerfens von Komponenten und bietet eine Umgebung, um diese zu zeichnen und zu model-
lieren.

1



1 Einführung

1.2 Einleitung in das Thema

Mit neuen Anwendungen im Bereich der Hochfrequenztechnik, insbesondere für Antennen
und Mikrowellenkomponenten, steigt das Interesse der Industrie elektromagnetische Felder
zu simulieren, um Aussagen zur E�ektivität, Optimierungsmöglichkeiten und Funktionalität
tre�en zu können. Auch regulative wie beispielsweise einschlägige Normen aus dem Bereich
der elektromagnetischen Verträglichkeit müssen von der Industrie eingehalten werden und
sind ein Anwendungsgebiet für Simulationen [2].
Mit einer Simulation können verschiedene Faktoren wie Strahlungscharakteristik, Ober�ächen-
ströme und Streuparameter ermittelt werden. Hierfür gibt es verschiedene Simulationssoftware
wie CST oder HFSS, welche bereits diese Möglichkeiten bieten. Die Funktion elektromagneti-
sche Feldprobleme lösen zu können, gewinnt stark an Relevanz, sodass diese Möglichkeiten
auch in bestehende Software eingearbeitet werden [3]. Ebenfalls interessant ist die Software
AWR Microwave O�ce aus dem Bereich der Hochfrequenztechnik, welche dem Benutzer erst
seit späteren Versionen die Möglichkeit bietet, elektromagnetische Feldprobleme zu lösen.
AWR Microwave O�ce zeichnet sich durch seine Vielseitigkeit aus, da es nicht nur ein Tool
für die Berechnung von Feldproblemen bietet, sondern auch die Simulation von Schaltungen
und Mikrowellenkomponenten ermöglicht [1]. Die Notwendigkeit mehrere spezialisierte Soft-
waretools für individuelle Simulationsanforderungen zu nutzen entfällt und kann von AWR
Microwave O�ce breit�ächig abgedeckt werden.
Je nach vorhandenen Möglichkeiten erfolgt die Implementierung der Designumgebung auf
unterschiedliche Weise. Die Hochfrequenzsoftware CST bietet eine Umgebung, die typisch für
das rechnergestützte Konstruieren, bekannt als CAD (Computer-Aided Design), ist [4]. AWR
Microwave O�ce ermöglicht den Aufbau auf verschiedenen vom Nutzer de�nierten Lagen,
einem sogenannten Stackup und verfügt zudem über eine Zeichenumgebung für 3D-Strukturen,
die eine CAD-Umgebung bietet [1]. Dies ist nur ein Beispiel für die Unterschiede moderner
Simulationssoftware.
Die Software AWR Microwave O�ce bietet diverse Möglichkeiten für die Simulation von
ganzen Platinenlayouts bis zu einzelnen Komponenten im Hochfrequenzbereich, mit hilfe ver-
schiedener Solver, welche Lösungsverfahren für die zu berechnenden Feldprobleme darstellen
[1]. Diese können teilweise auch als Solver für zweidimensionale Feldprobleme verwendet wer-
den, scheitern jedoch, wenn es um die Darstellung von Feldvektoren oder Wellenausbreitung
im Fernfeld geht [1]. Bei dem Solver “Analyst“ handelt es sich um den von Cadence ausgewie-
sene 3D Finite-Elemente-Solver, welcher für dreidimensionale Feldprobleme entwickelt wurde
und in dieser Arbeit mitunter untersucht wird [1].
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1 Einführung

Diese Arbeit untersucht, wie die Feldberechnung mit der Simulationssoftware AWR Micro-
wave O�ce funktioniert und basiert hauptsächlich auf einer explorativen Analyse. Um diese
Frage beantworten zu können, koordiniert diese Arbeit durch verfügbare Einstellung, die
Modellierung einer elektomagnetischen Struktur und Möglichkeiten in Bezug auf Rechenzeit.
Felddarstellungen sind hierbei nur ein Teil zur Beantwortung dieser Frage. Es sind Optionen
für das Anlegen von Materialien, die Behandlung von Simulationsgrenzen und das Meshing zu
beachten, um eine Aussage über die Möglichkeiten zu tre�en, welche diese Software bietet.
Neben der Untersuchung verfügbarer Einstellungen und ihrer Auswirkungen auf die Simulati-
onsperformance, wird ein direkter Vergleich gezogen, indem eine Patchantenne für 2.45 GHz
simuliert und die Simulationsergebnisse mit dem physischen Nachbau verglichen werden. Die
Patchantenne wird dazu in einer Antennenmesskabine vermessen.
Zum Abschluss dieser Arbeit werden die Ergebnisse und Einstellmöglichkeiten diskutiert,
welches helfen soll, die Möglichkeiten von AWR Microwave O�ce zu verstehen. Es werden
Auswertungen zugrunde der Simulationszeit, Rechenressourcen und Genauigkeit der Simu-
lationsergebnisse vorgenommen. Hierbei muss auch die Benutzerfreundlichkeit betrachtet
werden, da die Dauer des Designprozesses unmittelbar mit dieser zusammenhängt.

1.3 Ziele und Fragestellung der Arbeit

Mit neuen Funktionen von Simulationssoftware im Bereich der Elektrotechnik werden steigen-
de Qualitätsansprüche von Kunden an diese gestellt. Auch wenn es sich hierbei um Software
handelt, welche sich an professionelle Anwender richtet, sind gute Bedienbarkeit und viel-
fältige Einstellungsmöglichkeiten gefordert, um Analysemethoden an das zu simulierende
Problem anzupassen. Die Hochfrequenzsoftware AWR Microwave O�ce stellt sich in ihren
Anwendungsfeldern breit auf und bietet verschiedene Lösungsalgorithmen zum Simulieren
von elektromagnetischen Feldern. Neben der Simulation von planaren Strukturen sind Solver
zum Lösen volumetrischer Strukturen implementiert. Neben dem Standarteditor bietet AWR
Microwave O�ce eine 3D-Zeichenumgebung, welche die Bedienober�äche einer typischen
CAD-Umgebung aufweist. In dieser Arbeit wird die Hochfrequenzsoftware AWR Microwave
O�ce auf Einstellmöglichkeiten und das Arbeiten mit dieser Umgebung untersucht. Hierzu
sollen die in der Software bestehenden Möglichkeiten zu der Materialeinbindung, den Aufbau
von EM Strukturen und den Porteinstellungen aufgezeigt werden. Ebenfalls untersucht werden
Einstellungen, welche sich kritisch auf die Simulationsergebnisse auswirken. Hierbei wird
auf Grenzbedingungen, Einstellungen des Solvers und die Diskretisierung des Raumes mit
hilfe eines Gitternetzes eingegangen. Ein weiterer wichtiger Faktor hierbei ist ein Verständnis
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1 Einführung

für das Konvergenzkriterium. Nach Umsetzung einer Simulation anhand einer Patchantenne
werden kritische Einstellungen diskutiert. Diese wirken sich auf Genauigkeit, Rechenressour-
cen und Simulationsdauer aus, sind also für eine genaue Berechnung des Feldproblems unter
dem Aspekt der E�zienz wichtig. Diese Arbeit wird die genannten Optionen, welche AWR
Microwave O�ce dem Anwender überlässt, erläutern und die Auswirkung dieser auf die
Simulationserfahrung darstellen. Ziel ist es, dem Leser einen Eindruck auf die bestehenden
Möglichkeiten unter Verwendung des Solvers Analyst zu bieten, wodurch sich dieser einen
Überblick über die Handhabung der Software AWR Microwave O�ce scha�en kann.
Neben der Erklärung bestehender Funktionen und Einstellmöglichkeiten konzentriert sich
diese Arbeit auf die Fragen, die es ermöglichen, tiefere Einblicke in die Funktionalität von
Solvern für volumetrische Feldprobleme, wie Analyst, zu gewähren. Zentrale Fragestellungen
dieser Arbeit lauten:

1. Wie funktioniert die Simulation elektromagnetischer Felder in AWR Microwave O�ce
und welche Rolle spielen dabei die Solver und ihre spezi�schen Einstellungen?

2. Welche Möglichkeiten bietet die Software in Bezug auf die Anpassung von Materiali-
en, Grenzbedingungen und Gitternetzen und wie beein�ussen diese Einstellungen das
Simulationsergebnis?

3. Inwiefern tragen spezi�sche Einstellungen, wie das Konvergenzkriterium und die Aus-
wahl des Meshing-Verfahrens, zur Genauigkeit und E�zienz der Simulation bei?

Durch die Beantwortung dieser Fragen erläutert die Arbeit die komplexen Interaktionen
zwischen den verschiedenen Einstellungen und ihren Ein�uss auf die Simulationsergebnisse. Es
soll ein umfassendes Verständnis der Simulationsprozesse in AWR Microwave O�ce gescha�en
werden und praxisnahe Empfehlungen für die Nutzung der Software sollen geboten werden.
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2 Theoretischer Hintergrund

2.1 Berechnung von Feldproblemen in So�ware

Die Aufgabe elektromagnetischer Felder in Simulationssoftware zu berechnen und das Feld-
problem darstellbar zu machen, kann in mehrere Schritte unterteilt werden. Hierbei bilden
Diskretisierung mit hilfe eines Gitternetzes, die Charakterisierung der Ports und die Lösung
der Streumatrix Arbeitsblöcke, welche in einer Simulation abgearbeitet werden.
Der Ablauf hierbei kann entsprechend durch Änderungen am Lösungsalgorithmus abweichen.
Hierbei wird zunächst der Port diskretisiert und dieser Vorgang nach Erreichen einer Konver-
genz des Wellenwiderstands beendet. Eine Diskretisierung des Raumvolumens �ndet statt und
ist ebenfalls fertiggestellt, nachdem das Konvergenzkriterium für die Streuparameter erreicht
ist. Diese Abläufe zur Diskretisierung werden durch den Algorithmus des “Advanced Mesh
Re�nement“ bestimmt. Auswirkung auf die Genauigkeit hierbei hat die Meshingfrequenz, für
welche die entsprechenden Streuparameter und Wellenwiderstand ermittelt werden. Nachdem
die Diskretisierung abgeschlossen ist, wird das Feldproblem mit hilfe der Finiten-Elemente-
Methode gelöst.

2.2 Finite-Elemente-Methode

Als erster Schritt in dieser Berechnungsmethode wird das Raumvolumen unterteilt, um das
Feldproblem in Teilprobleme zu überführen. Hierzu sind Algorithmen wie „Advanced Mesh
Re�nement“ implementiert, um eine für das Konvergenzkriterium hinreichende Aufteilung in
Finite-Elemente vorzunehmen. Nachdem der Raum auf das Konvergenzkriterium passend dis-
kretisiert wurde, werden die Maxwell-Gleichungen für jede Zelle de�niert. Die Formulierungen
berücksichtigen die zeitliche Änderung der Felder und werden in Form von partiellen Di�eren-
tialgleichungen für jedes Element ausgedrückt. Hierbei werden diese für die Berücksichtigung
von Materialparametern und Randbedingungen modi�ziert [5].
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2 Theoretischer Hintergrund

Die Maxwell-Gleichungen in Di�erentialform lauten:

∇×E = −∂B
∂t

(2.1)

∇×H = J +
∂D

∂t
(2.2)

∇ ·D = ρ (2.3)

∇ ·B = 0 (2.4)

wobei E die elektrische Feldstärke, B die magnetische Flussdichte, H die magnetische Feld-
stärke, J die Stromdichte, D die elektrische Flussdichte und ρ die elektrische Ladungsdichte
darstellen.
Um das Problem für jedes Element approximieren zu können, werden Shape Funktionen ver-
wendet, welche Interpolationspolynome sind [5]. Die Aufgabe dieser liegt darin, das Verhalten
des Feldes für jedes Element anhand der bekannten Knotenpunkte zu nähern, um aus einer
diskreten Lösung eine kontinuierlich darstellbare zu machen [5]. Außerhalb des Meshelements
sind diese Funktionen null.
Beispielsweise wird das elektrische Feld E in einem Element durch eine Linearkombination
dieser Funktionen dargestellt:

E(x, y, z) =
n∑

i=1

Ni(x, y, z)Ei (2.5)

wobei Ni die Shape Funktionen und Ei die Knotenwerte des elektrischen Feldes sind.
Anschließend wird ein Gesamtsystem von Gleichungen für die gesamte Struktur erstellt.

Ax = b (2.6)

Hierbei ist A die Systemmatrix, welche durch Koe�zienten die Feldgrößen an Kanten oder
Knoten beschreibt, x der Lösungsvektor, der die unbekannten Feldwerte enthält, die berechnet
werden sollen, und b der Quelltermvektor, der Werte aus Quellen wie elektrische Ladungen,
Ströme oder vorgegebene Feldstärken enthält und somit die Anregung des Systems repräsen-
tiert.
Das Gleichungssystem wird numerisch gelöst. Die Lösung liefert die Werte der elektromagne-
tischen Felder der �niten Elemente.
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2 Theoretischer Hintergrund

2.3 Vorstellung der Simulationsso�ware AWR

AWR Microwave O�ce von Cadence Design Systems ist eine umfassende Softwarelösung,
die in der Elektrotechnik für eine Vielzahl von Anwendungen eingesetzt wird. Sie �ndet in
der Industrie Anwendung für die Simulation und Analyse von Mikrowellenkomponenten,
Schaltkreisen und Feldberechnungen. Mit der Implementierung von Analysetools für ther-
mische Prozesse wurde die Software auch für andere Fachbereiche erweitert und versucht
ein breites Feld von Kunden abzudecken. In dieser Software können Nutzer komplexe Frage-
stellungen der Elektrotechnik angehen. Dies umfasst die Simulation von Schaltkreisen, die
Optimierung von Komponentenparameter, wie etwa für Filterschaltungen und das Design
ganzer Platinenlayouts. Hierbei hervorzuheben ist die Fähigkeit der Software, Modellierung
in einer zweidimensionalen Umgebung auf Basis verschiedener Lagen zu ermöglichen, doch
auch die Modellierung von volumetrische Strukturen im 3D-Editor zu ermöglichen.
Neben bestehender Designmöglichkeiten bietet die Software Analysetools, welche nach der
Simulation Datensätze für das Post-Processing bereitstellt. Hierbei bilden Streumatrizen, Strah-
lungscharakteristiken und Felddarstellungen nur wenige Möglichkeiten, welche zu einer Aus-
sage der Funktionalität beitragen.
AWR Microwave O�ce bietet eine einheitliche Bedienober�äche für alle zu untersuchenden
Probleme. Vor dem Modellierungsprozess einer EM-Struktur wird eines der Lösungsverfahren
ausgewählt, wobei diese unterschiedlichen Schwerpunkte für verschiedene Simulationen bieten.
Die asynchrone Eigenschaft der Simulatoren bedeutet hierbei, dass die Simulation nicht in der
Hauptsoftware statt�ndet und eine Simulation die Arbeit des Nutzers nicht beeinträchtigt [1].
Eine Au�istung der Simulatoren be�ndet sich in anstehender Tabelle 2.1.
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2 Theoretischer Hintergrund

Simulator Beschreibung
Axiem Asynchroner Method of Moments Simulator. Entwickelt für die

Analyse planarer Strukturen
Analyst Asynchroner 3D FEM Simulator. Geeignet für die umfassende

Analyse dreidimensionaler Strukturen.
Clarity 3D Solver Elektromagnetischer Solver, asynchron. Für detaillierte 3D elek-

tromagnetische Feldanalysen.
EMX Planar 3D Solver Asynchroner elektromagnetischer Solver. Fokussiert auf die Si-

mulation von planaren 3D-Strukturen.
Celsius Thermal Solver Thermischer Solver, asynchron. Zur Analyse und Simulation ther-

mischer E�ekte.
ACE Automated Circuit
Extractor

Simulation mehrlagiger Leiterbahnen und Schaltkreise.

EMSight Simulator Ermöglicht die elektromagnetische Simulation von 2.5D-
Strukturen. Besonders geeignet für planare und leicht dreidi-
mensionale Strukturen.

Tabelle 2.1: Übersicht der Simulatoren in AWR Microwave O�ce.

Das Benutzerinterface der Hauptsoftware ist hierbei, intuitiv und übersichtlich gestaltet.
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2 Theoretischer Hintergrund

Abbildung 2.1: Übersicht über das Standartinterface mit Hervorhebung wichtiger Bestandteile.

Wie in der Abbildung 2.1 sichtbar, be�nden sich standardmäßig die Menüleiste und Werkzeu-
gleiste im oberen Abschnitt des Fensters. In der Werkzeugleiste be�nden sich Optionen zum
Einfügen von Schaltkreisen, doch auch der Start der Simulation �ndet hier Platz. Wenn in
den unteren Tabs der Projektreiter ausgewählt ist, sind Ordner wie “Project Options“, “Daten-
sätze“ und Gra�ken sichtbar. Die Strukturen bzw. Objekte für die Feldberechnung be�nden
sich in dem Ordner “EM Structures“. Nach erfolgreicher Simulation werden die Datensätze
zur eventuellen Weiterverarbeitung in den “Data Sets“ Ordner zur Verfügung gestellt. In den
“Gra�kordner“ können beliebige Gra�ken wie Smithcharts, Rectangular, Antenna Plots, polare
Gra�ken als auch 3D Plots erstellt werden. Mit dem Reiter “Layout“ können verschiedene Lagen
im Designprozess ein- und ausgeblendet werden. In dem Reiter “Elements“ stehen verschiedene
Bauteile zur Verfügung, wobei aufgrund der von AWR gep�egten Libraries viele weitverbreitete
Bauteile von verschiedenen Herstellern zur Verfügung stehen. Bauteile können von dort aus
in die Arbeits�äche gezogen werden. Die unteren Tabs sind während des Designprozesses frei
anwählbar, um eine �exible Arbeitsweise zu gewährleisten.
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2 Theoretischer Hintergrund

Das anstehende Arbeits�ussdiagramm soll helfen, die standardmäßigen Schritte zur Erstellung
einer Struktur bis zur ersten Simulation zu verstehen.
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2 Theoretischer Hintergrund

Abbildung 2.2: Arbeits�ussdiagramm zur Darstellung der nötigen Schritte bis zur ersten Simu-
lation.
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2 Theoretischer Hintergrund

In AWR Microwave O�ce wird mit hilfe vom Benutzer festgelegter Lagen die Struktur erstellt,
welche später simuliert werden soll. So werden in den Materialde�nitionen lediglich elektrische
Eigenschaften de�niert. Unter Materials werden diese dann in ihrer Dicke beschrieben. Ein
einfaches Beispiel für den Lagenaufbau einer einfachen Platine mit einer Substrathöhe und
einer Leiterbahndicke, wobei die Groundplane ebenfalls dieser Leiterbahndicke entspricht,
ist in folgender Abbildung gegeben. Hierbei ist die Platine von beiden Seiten mit 10 mm Luft
umgeben.

Abbildung 2.3: Menü zur Einstellung der Lagen mit 10 mm Luft ober- und unterhalb der
Leiterbahndicke und der Substrathöhe mittig.

Es werden in diesem Beispiel alle Lagen als Luft angegeben, da sich gewählte Materialien
sonst automatisch bis zu der Simulationsgrenze ausbreiten und in ihrer Dimension nicht
mehr regulierbar sind. Über Auswählen der Zeichenebene, kann zwischen den verschiedenen
Lagen gewechselt werden. Wenn in dem gezeigten Beispiel das Substrat eingefügt werden soll,
geschieht dies, indem die Zeichenebene 4 ausgewählt und ein Rechteck gezogen wird, welches
der Breite und Länge des Substrates entspricht. Es wird die Zeichenebene 4 ausgewählt, da in der
Lagenansicht das Substrat auf diese Ebene aufgelegt wird. Die Höhe dieses Rechtecks entspricht
dem zugewiesenen Material, ist also durch die Angaben in den “Materials“ bedingt, da dort
die Höhe angegeben wird. Eine Materialzuweisung kann über die Option Shape Properties
erfolgen, welche über einen Rechtsklick auf die Struktur erscheint.
Der erzielte E�ekt, wenn eine Lage eine Materialzuweisung erhält oder dieses als Struktur
mit zugewiesenen Materialeigenschaften gezeichnet wird, ist in der nachstehenden Abbildung
sichtbar.
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2 Theoretischer Hintergrund

(a) Das Material wird bis zu der Simulationsgrenze
gezogen; blau dargestellt ist das Dielektrikum

(b) Das Material wurde vom Nutzer selbst zugewie-
sen, um gewünschte Maße einzuhalten. Der äu-
ßere Kasten stellt die Simulationsgrenze dar und
der innere blaue das Dielektrikum

Abbildung 2.4: Links wurde der Schicht ein Material zugewiesen. Es erstreckt sich bis zu der
Simulationsgrenze. Rechts wurde eine Struktur auf einer Lage erstellt, einem
Material zugewiesen und es erstreckt sich nicht bis zur Simulationsgrenze

Abbildung 2.5: Shape Properties, nachdem das gezeichnete Substrat dem Material “Diel“ zuge-
ordnet wurde.

Um volumetrische Objekte zu modellieren, kann nach Erstellen einer neuen Struktur über
Rechtsklick > Open in 3D-Editor eine CAD-Umgebung geö�net werden. In dieser Umge-
bung stehen Materialien zur Verfügung, welche zuvor in AWR Microwave O�ce unter der
Enclosure angelegt wurden [1].
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Abbildung 2.6: CAD Umgebung des 3D-Editors.

Hierbei sind über oben angelegte Reiter, Funktionen zum Modi�zieren der Formen verfügbar.
Neben geometrischen Formen, welche der Erstellung von Elementen dienen, können Elemente
über boolsche Funktionen bearbeitet werden.
Über Draw > Add Subcircuit kann eine in dem 3D-Editor erstellte Struktur in die Standardar-
beits�äche hinzugefügt werden. So können über den standard Editor die planaren Strukturen,
wie Platinenschichten, modelliert werden und über den 3D-Editor Bauteile, wie Koaxialstecker,
eingefügt werden. Beide Editoren vereint bilden hierbei die Möglichkeiten komplexe Strukturen
zu modellieren und sie für eine Simulation vorzubereiten.
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Neben dem Solver AXIEM steht in AWR Microwave O�ce der Analyst Solver zur Verfügung.
Dieser bietet im direkten Vergleich einige Vorteile und wird auch von Cadence als Solver für
volumetrische Feldprobleme angegeben. Axiem hingegen ist für planare Feldprobleme geeignet
[1].
Analyst bietet als Solver Vorteile, wie die Verfügbarkeit von Waveports, welche für die Simula-
tion von Antennen von Interesse sind. Ebenfalls ist Analyst für dreidimensionale Strukturen
geeignet, da das Gesamtvolumen bis zur Grenzbedingung diskretisiert wird. Auch Leiterstrei-
fen und komplexere Strukturen können in ihrem Volumen feiner diskretisiert werden, um
beispielsweise den Skin-E�ekt genauer zu berücksichtigen.
In den folgenden Kapiteln wird auf verschiedene Aspekte eingegangen die AWR Microwave
O�ce bietet und die einen Ein�uss auf die Lösung des Feldproblems haben. Hierzu werden
nicht nur Möglichkeiten bezüglich Materialien aufgezeigt, sondern auch Einstellungen für
Grenzbedingungen, Solver und Ports beschrieben. Die Diskretisierung des Volumens mit hilfe
eines Gitternetzes und Konvergenzbedingungen bilden eine wichtige Komponente, wenn es
auf die Genauigkeit der Simulation ankommt und werden ebenfalls erläutert.

3.1 Materialien

In AWR Microwave O�ce werden Nutzern vielfältige Möglichkeiten geboten eigene Materiali-
en zu integrieren. Nachdem eine EM Struktur angelegt wurde, sind zunächst grundsätzliche
Einstellungen dieser vorzunehmen. Unter anderem werden hierbei gewünschte Materialien
de�niert und im Anschluss in ihrer Dimension beschrieben.
Wie in Abbildung 3.1 dargestellt, können über die nebenstehenden Schalt�ächen Materiali-
en in der Kategorie Dielektrikum, Leiter oder Impedanzen angelegt oder gelöscht werden.
Auch eine erweiterte Einstellmöglichkeit ist vorhanden, welche die Materialien in ihren dreidi-
mensionalen Eigenschaften beschreibt. Dabei erfolgt die Angabe von Dielektrizitätskonstante,
Permeabilität oder Bulk Conductivit in verschiedene Raumrichtungen. Es wird zum Hinzufügen
eines neuen Dielektrikums zunächst nach der relativen Permeabilität, Name und den Verlusten
tan(δ) gefragt. Über die Schalt�äche „Advanced“ können noch magnetische Eigenschaften

15



3 Simulationssoftware-Einstellungen

kon�guriert werden. Für das Hinzufügen eines neuen Leitermaterials muss lediglich Name
und Leitwert angegeben werden. Ein Widerstandsmaterial kann mit hilfe des Widerstands
im niederfrequenten Bereich, dem Verlustkoe�zienten im hochfrequenten Bereich und der
Ober�ächenreaktanz, beschrieben werden.

Abbildung 3.1: Einstellungsfenster für die De�nition von Materialien in AWR Microwave O�ce.

Nach der Materialde�nition erfolgt die Spezi�kation der Dimensionen im Fenster “Materials“.
Das Hinzufügen oder Löschen von Materialien geschieht erneut über die nebenstehenden
Schalt�ächen. Durch das Auswählen einer Zelle können die darin enthaltenen Werte verändert
werden. Die Dicke eines Materials wird hierbei mit Übereinstimmung der globalen Einheiten
angegeben. Nachdem ein Name und die Dicke des Materials angegeben ist, erfolgt die Materi-
alzuweisung. Der Wert in der Zelle “Roughness“ entspricht der e�ektiven Ober�ächenrauheit
und stellt eine wichtige Information für absichtlich angeraute Ober�ächen dar, da diese bei
Berechnung im Hochfrequenzbereich aufgrund des Skin-E�ektes zu berücksichtigen ist. Die
Option “Solve Inside“ ermöglicht ebenfalls ein feineres Gitternetz innerhalb des Materials, um
die Genauigkeit bezüglich des Skin-E�ektes zu erhöhen.
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Abbildung 3.2: Einstellungsfenster für das Anlegen von Materialien, um diese in der Simulati-
onsumgebung zur Verfügung zu stellen.

Nur wenn ein Material in dem Reiter Materials hinzugefügt worden ist, wird dieses in der
Modelationsumgebung zur Verfügung stehen. Die Angabe der Dicke stützt sich auf der Vorge-
hensweise, das System in einer zweidimensionalen Draufsicht zu zeichnen, während andere
Simulationstools wie CST Studio Suite einen CAD-Modellierungsansatz verfolgen, in welchem
ohnehin die Dimensionen in jede Richtung angegeben werden müssen [4].

3.2 Ports

Um die modellierten Systeme anzuregen, werden Ports an diese angelegt, welche als Schnittstel-
le für Input und Output dienen. AWR Microwave O�ce bietet in der Simulationsumgebung eine
Auswahlmöglichkeit an Ports, welche an die Struktur angelegt werden können. Hierbei gibt es
Möglichkeiten, die Platzierung der Ports zu steuern und durch Funktionen wie de-embedding,
Edge Ports und Point Ports die Genauigkeit und Relevanz der Simulation zu erhöhen.
Über die Werkzeugleiste oder über das Zeichenmenü können Ports ausgewählt und an die Struk-

17



3 Simulationssoftware-Einstellungen

tur gelegt werden. Hierbei muss zunächst zwischen Edge Ports und Point Ports unterschieden
werden.

(a) Leiterstreifen mit einem Edge Port. (b) Leiterstreifen mit einem Point Port.

Abbildung 3.3: Darstellung von Edge und Point Port an einem Leiterstreifen.

Point Ports werden in das Zentrum einer leitenden Struktur gelegt. Sie stellen punktförmige
Anschlüsse in kleinen Bereichen der Schaltung dar. Dies ist vergleichbar mit Anschlusspunkten
von diskreten Bauelementen.

Edge Ports werden an Ränder von Übertragungsleitungen oder an Kanten von �achen Struk-
turen wie Streifenleiter gelegt. Diese eignen sich für Simulation von Leitungseigenschaften
und Interaktion mit anderen naheliegenden Leitungen. Implizite Edge Ports haben hierbei
keinen direkten Bezug zu einer Masse�äche und de�nieren sich in Bezug auf Spannung und
Strom. Die Spannung wird dabei vom Rand, an dem der Port platziert ist, bis zu einer unendlich
ausgedehnten Masseeben de�niert. Dies funktioniert insbesondere bei niedrigen Frequenzen,
da diese De�nition unabhängig vom Pfad ist. Um dispersive E�ekte zu berücksichtigen, gibt es
die Möglichkeit, den Port mittels Leiterstreifen mit naheliegenden Masse�ächen zu verbinden.
Da eine solche Verbindung eine Diskontinuität verursachen kann, sollte de-embedding in
Betracht gezogen werden [1].
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Abbildung 3.4: Aufbau eines impliziten Edge Ports. Adaptiert aus [1].

Durch Anwählen eines abgelegten Ports werden die Einstellungen für diesen geö�net.

Abbildung 3.5: Menüfenster für die Portkon�guration.

Das de-embedding stellt in der Simulation von Hochfrequenzkomponenten eine wichtige
Funktion dar. Es ermöglicht, die Auswirkung anderer Bauteile, welche außerhalb des zu ana-
lysierenden Bereichs liegen, herauszurechnen und sich somit auf einen spezi�schen Teil der
Schaltung zu konzentrieren. Dies ermöglicht eine genauere Charakterisierung von Hochfre-
quenzkomponenten wie Filtern, Verstärkern und Antennen, da angrenzende Schaltungsele-
mente nicht berücksichtigt werden.
In der folgenden Abbildung sieht man eine Darstellung einer Mikrostreifenleitung mit einem
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Edge Port, bei dem De-Embedding angewendet wird. Die gestrichelte Linie repräsentiert den
Bereich, innerhalb dessen die portbezogenen E�ekte von der Simulation entkoppelt werden,
um die reinen Leitungseigenschaften zu analysieren.

Abbildung 3.6: Edge Port mit de-embedding-Bereich.

Eine weitere Möglichkeit der Portvergabe sind die di�erentiellen Ports. Diese dienen der
Simulation von di�erenziellen Signalwegen, wie sie bei der di�erentiellen Datenübertragung
zum Einsatz kommen. Um diese Ports zu kon�gurieren, werden zwei Edge Ports verwendet,
bei welchen einer als positiver Anschluss und der andere als negativer Anschluss fungiert. Dies
spiegelt sich in der Portnummer wider, da der negative Anschluss ein Minuszeichen vorange-
stellt bekommt. Da das Signal in Bezug auf den anderen Port und nicht auf die Masseebene
gemessen wird, ist es wichtig keine Massereferenz herzustellen.

Abbildung 3.7: Di�erentialport-Kon�guration mit einer Wechselspannungsquelle und di�eren-
ziellen Anschlüssen für die Signalanalyse. Adaptiert aus [1].
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Waveports sind ein spezieller Typ von Ports, um Wellenleiter und Streifenleiter anzuregen.
Anders als bei Point Ports oder Edge Ports, modelliert ein Waveport die Einkopplung einer
elektromagnetischen Welle in eine Struktur. Diese Ports sind für die Hochfrequenztechnik von
besonderer Wichtigkeit, da diese zur Berechnung von Antennenparametern, Filtern oder auch
Kopplern, über ein- und auslaufende Wellen benötigt werden.
Hierbei wird eine Fläche an den Port gelegt, welche die Struktur anregt. Da ein Waveport mit
der Grenzbedingung abschließen oder außerhalb dieser liegen muss, wird bei de-embedding ein
Fehler verursacht, welcher die Simulation nicht starten lässt. Bei Waveports wird automatisch
die Fläche der Simulationsgrenze angenommen und somit die gesamte Seite angeregt. Dies
kann jedoch unterbunden werden, indem “Wave Custom Size“ als Port ausgewählt wird. Hierbei
muss die Fläche angegeben werden, welche der Waveport an der Grenze annimmt[1].
Die Fläche eines Waveports kann hierbei große Auswirkungen auf die Simulationsergebnisse,
wie beispielsweise auf Verkopplung von Antennen, haben [6]. Daher ist die Angabe geeigneter
Maße eines benutzerde�nierten Waveports wichtig, welche jedoch nicht universell beschrieben
werden können.
Bei der Berechnung der Waveport-Fläche für einen rechteckigen Wellenleiter, zum Beispiel,
sollte die Fläche mindestens so groß wie der Querschnitt des Wellenleiters sein. Dies stellt
sicher, dass der Waveport die gesamte Struktur e�ektiv anregt.
Die nachstehende Tabelle 3.1 gibt einen Überblick über die verfügbaren Ports und wie diese
mit Ground verbunden sind.

Porttyp Beschreibung
Lumped Di�erential Ports mit di�erentiellen Signal.
Lumped Down Ports mit nach unten liegenden Ground verbunden.
Lumped Up Ports mit nach oben liegenden Ground verbunden.
Lumped Up/Down Ports mit nach oben und unten liegenden Ground verbunden.
Lumped As In Child Beschreibung des Einsatzbereichs für Lumped As In Child Ports.
Wave Waveports simulieren die Anregung durch einen unendlich lan-

gen Wellenleiter, wobei eine Welle über die gesamte Fläche einer
Seite der Simulationsgrenze eingekoppelt wird. Dies ermöglicht
die vollständige Berücksichtigung der Struktur auf dieser Seite
für die Wellenausbreitung.

Wave Custom Size Waveports mit spezi�zierter Größe begrenzen die Anregung auf
einen de�nierten Bereich. Diese Ports simulieren einen unendlich
langen Wellenleiter, der die Welle nur innerhalb des festgelegten
Gebiets einkoppelt, was für eine gezielte Simulation von Wellen-
leitere�ekten nützlich ist.

Tabelle 3.1: Übersicht über Porttypen in AWR Microwave O�ce.
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3.3 Boundaries

In elektromagnetischen Simulationen ist das Festlegen von Grenzbedingungen (Boundaries)
nötig, um den Bereich zu de�nieren, in dem das Feldproblem gelöst wird. Nur innerhalb
dieser Grenzbedingung wird das Feldproblem gelöst und im späteren darstellbar gemacht.
Um die Grenzbedingung an das Feldproblem anzupassen, können verschiedene Einstellungen
vorgenommen werden, welche die Form als auch Grenzbedingungen beinhalten. Dem Nutzer
wird viel Freiheit geboten, da es diverse Möglichkeiten gibt, die Grenzbedingungen anzupassen.
Eine Besonderheit ist die Möglichkeit, für unterschiedliche Seiten der Grenze verschiedene
Optionen festzulegen oder de�nierte Materialien als Boundary zuzuweisen. Diese Möglichkeit
dient der Simulation von Gehäusen, welche aus verschiedenen Materialien bestehen können.
Abbildung 3.8 zeigt die festgelegte Simulationsgrenze, welche rot dargestellt ist. Das Gitternetz,
sichtbar innerhalb der Grenze, verdeutlicht, dass die Diskretisierung nur bis zu dieser Grenze
erfolgt. Außerhalb dieser Grenze �ndet keine Simulation beziehungsweise Berechnung des
Feldproblems statt.

Abbildung 3.8: Die Simulationsgrenze ist rot dargestellt. Ebenfalls ist das Gitternetz sichtbar,
welches lediglich bis zu dieser Grenze gezogen wird.

Sofern nicht anders de�niert, wird die Grenzbedingung automatisch als “Approx Open“ ange-
nommen, dies bedeutet, dass keine abschließende Grenze angenommen wird und das Material
Luft ist. Diese Möglichkeit ist jedoch nur eine von mehreren, um die Grenzbedingung an das
jeweilige Feldproblem anzupassen. Für abstrahlende Strukturen wie eine Patch-Antenne ist
die “Perfectly Matched Layer“ (PML) vorgesehen, welche einen Wellenwiderstand von 377 Ω

aufweist. Mit der PML-Boundary wird ein Hilfsmesh de�niert, welches sich an das FEM-Mesh
anknüpft. Dieses Hilfsnetz ist mit einem Medium gefüllt, welches sich an das Hauptmesh impe-
danzmäßig anpasst. Dadurch durchdringen die Felder die Boundary ohne große Re�exionen.

22



3 Simulationssoftware-Einstellungen

Abbildung 3.9 zeigt ein Beispiel, in dem die seitliche Grenze als "Perfectly Matched Layer"de�niert
wird.

Abbildung 3.9: Eine Grenzbedingung wird für die seitliche Grenze ausgewählt.

Mögliche Einstellungen sind in anliegender Tabelle erläutert. Hierbei können die E�ekte auf das
elektrische und magnetische Feld mit vertikaler oder horizontaler Polarisation hinzugezogen
werden. Für die empfohlene Größe der Boundary bzw. der Abstand zu der modellierten Struktur
wurden die Empfehlungen von Cadence aus der AWR Dokumentation hinzugezogen.
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Grenzbedingung E�ekt auf E
und H

Größenempfehlung
der Boundary

Nutzungshinweis

Perfekter Leiter oder
(PEC)

Eh = 0, Hv = 0 Typischerweise
verwendet, um eine
Struktur in einem
leitenden Gehäuse
zu modellieren, also
Größe passend zum
tatsächlichen Gerät
de�nieren.

Keine Angabe.

Perfekter magneti-
scher Leiter

Ev = 0, Hh = 0 5-10x Substrathöhe
entfernt von Metall-
formen.

Eine Alternative zu Nä-
herungsweise o�en für
nicht abstrahlende Struk-
turen.

Impedanz Eh/Hh = Z Typischerweise
verwendet, um eine
Struktur in einem
leitenden Gehäuse
zu modellieren, also
Größe passend zum
tatsächlichen Gerät
de�nieren.

Diese Auswahlmöglich-
keiten haben Namen, die
Materialde�nitionen wie
Tantal oder Cap Bottom
entsprechen.

Näherungsweise
o�en (Approximate
Open)

Eh/Hh = 376.7 5-10x Substrathöhe
entfernt von Metall-
formen.

Verwendet bei nicht ab-
strahlenden Strukturen,
um freien Raum anzunä-
hern, und bei abstrah-
lenden Strukturen, wenn
Geschwindigkeit vorran-
gig ist.

Perfectly Matched
Layer (PML)

Keine Angabe. Mehr als λ/4 ent-
fernt von Metallfor-
men.

Bestimmt für den Einsatz
in wahrhaft abstrahlen-
den Strukturen. Rechen-
intensiv.

Electric Symmetry Ev = 0, Hh = 0 Keine Angabe. Bei elektrischer Symme-
trie der Struktur.

Magnetic Symmetry Eh = 0, Hv = 0 Keine Angabe. Bei magnetischer Sym-
metrie der Struktur.

Tabelle 3.2: Übersicht der Grenzbedingungstypen in elektromagnetischen Simulationen. Adap-
tiert aus [1].
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3.4 Meshing und Konvergenz

Um eine fundierte Aussage über die Feldstärke und Wellenausbreitung im Raum tre�en zu
können, ist es notwendig, das Volumen innerhalb der Simulationsgrenzen zu diskretisieren.
Ob die durch das gezogene Mesh entstandene Diskretisierung ausreichend ist oder ob eine Ver-
feinerung notwendig wird, hängt von dem in der Software festgelegten Konvergenzkriterium
ab. Hierbei wird geprüft, ob Betrag oder Phasenwinkel der Streumatrix eine weitgehend kleine
Änderung, zwischen den Iterationen aufweisen und die Gitternetzbildung nach Erreichen der
gesetzten Kriterien beendet. Dabei wird das Gitternetz mit jeder Iteration verfeinert und die
Streumatrix mit vorhergegangener Iteration verglichen[1]. Trotz dieser Herangehensweise ver-
fügen viele Simulationstools über Einstellungen, welche es ebenfalls zu berücksichtigen gilt, da
diese beispielsweise eine Diskretisierung auf einer nicht vorgesehenen Frequenz durchführen,
die Konvergenzkriterien zwar eingehalten werden, doch die Gitternetzbildung nicht zu dem
Feldproblem passt. Um die Diskretisierung hinreichend zu gestalten, ist es nötig einige Einstel-
lungen zu betrachten und ihre Auswirkung auf den Prozess vor der eigentlichen Feldsimulation
zu verstehen. Eine zu grobe Diskretisierung kann hierbei zu ungenauen Ergebnissen führen,
während eine hohe Anzahl von sehr kleinen Zellen einen hohen Rechenaufwand bedeuten.
Da die Genauigkeit der Simulation auch von dem diskretisierten Raum abhängt, gibt es mehrere
Möglichkeiten das Gitternetz zu steuern. Hierbei können diese Einstellungen auf verschiedenen
Ebenen angewandt werden. Die Anwendung auf Projektebene wendet die Einstellungen auf
alle in dem Projekt be�ndlichen EM Strukturen an. In den Einstellungen der EM Struktur
können Einstellungen getro�en werden, welche nur für die entsprechende Struktur angewandt
werden. Ebenfalls besteht die Möglichkeit, die Gitternetzbildung einzelner Elemente einer
Struktur anzupassen[1].
Die Bildung dieses Gitternetzes ist hierbei ein zeitkritischer Prozess und steuert neben der
Dauer um ein entsprechendes Konvergenzkriterium zu erreichen, auch die benötigten Re-
chenressourcen. Dies wird in Abbildung 3.10 deutlich, welche die Anzahl der Elemente mit
jeder weiteren Iteration zeigt. Sichtbar ist ebenfalls der benötigte Arbeitsspeicher, welcher mit
jeder weiteren Iteration wächst.
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Abbildung 3.10: Entwicklung der Elementanzahl und des Peak Memorys während des Meshing-
Prozesses.

In der folgenden Tabelle 3.3 sind verschiedene Einstellungsmöglichkeiten und deren Beschrei-
bungen aufgeführt, die sich auf die Entwicklung des Gitternetzes und dessen Anpassung an die
zu simulierende Struktur beziehen. So können Zellen innerhalb eines Materials gesteuert wer-
den, doch auch die Größe der Zellen und somit die Anpassungsfähigkeit an kleinere Merkmale
am Material. An das Feldproblem angepasste Meshing-Einstellungen sind wesentliche Aspekte
für die Genauigkeit und E�zienz der Simulation. Von der Komplexität des Feldproblems und
den Materialien abhängig, können diese Einstellungen einen erheblichen Ein�uss auf die
Rechenzeit und Genauigkeit haben.
Für die Diskretisierung dünner Leiterbahnen emp�ehlt Cadence die Annahme mit einer Ma-
terialdicke von null, um die Diskretisierung der Struktur zu beschleunigen und dennoch
zuverlässige Simulationsergebnisse zu erzielen [1]. Hierdurch werden jedoch E�ekte in dem
Leiter vernachlässigt, welches zu fehlerhaften Simulationsergebnissen führen kann. Anwen-
dungsfälle hierfür sind Simulationen im niederfrequenten Bereich oder wenn die Dicke des
Materials im Vergleich zur Wellenlänge vernachlässigbar ist.
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Einstellung Beschreibung
Model As Zero Thickness Nimmt an, dass die Struktur eine Dicke von 0,0 mm aufweist.
Size Type Angabe, ob es sich um eine relative oder absolute Größenangabe handelt.

Dies kann die Iterationen von AMR verlängern.
Relative Mesh Size Maximale Kantenlänge einer Meshzelle zwischen Luft und Boundary.
Absolute Mesh Size Maximale Kantenlänge einer Meshzelle.
Size Propagation Factor Übergangsrate von groben zu feinen Bereichen. Werte zwischen 0 und

1. Kleinere Werte führen zu schnelleren Übergängen.
Curvature Re�nement Type Angabe, ob die Krümmungsverfeinerung durch relative Elementgröße

oder Arbeitslängeneinheit bestimmt wird.
Absolute Curvature Re�ne-
ment Size

Steuert die Genauigkeit, mit welcher das Netz an gekrümmten Flächen
und Kanten dargestellt wird. Darstellung in Arbeitslängen und größer
als 0,0.

Relative Curvature Re�ne-
ment Size

Steuert die Genauigkeit, mit welcher das Netz an gekrümmten Flächen
und Kanten dargestellt wird. Zwischen 0,0 und 0,5. Relative Größenan-
gabe.

Anisotropic Curvature Re�-
nement

Durch Aktivierung dieser Funktion beschränkt sich die Krümmungsver-
feinerung auf gekrümmte Richtungen. Elemente wie Zylinder erhalten
weniger Zellen.

Relative Minimum Curva-
ture Size

De�niert die kleinste Zelle, welche bei einer Krümmung erzeugt wird.
Dies ist eine Verfeinerungsstufe und der Wert ist relativ zur maximalen
Elementgröße.

Absolute Minimum Curva-
ture Size

De�niert die kleinste Zelle, welche bei einer Krümmung erzeugt wird.
Der Wert wird in Arbeitslängen de�niert.

Enable Small Feature Sup-
pression

Kleine Details, welche Probleme im Meshingvorgang verursachen kön-
nen, werden unterdrückt.

Absolute Small Feature Sup-
pression Tolerance

Längenwert, welcher in der Größenordnung von 0,0 liegt. Ein größerer
Wert verringert die Fehlerwahrscheinlichkeit beim Meshing, kann je-
doch dazu führen, dass die Strukturen ihre genaue Geometrie verlieren.

Enable Local Mesh Controls Wenn diese Option aktiviert ist, wird die Vernetzung durch die lokale
Geometrie gesteuert.

Tabelle 3.3: Übersicht der Mesh-Einstellungen in AWR Microwave O�ce.

3.4.1 Konvergenzkriterien

Ob ein Gitternetz eine hinreichende Au�ösung bietet, wird über die Konvergenzkriterien
de�niert. Diese vergleichen hierbei den Betrag und die Phase der Streuparameter, zwischen
zwei verschiedenen Iterationen.
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Mathematisch lassen sich diese Unterschiede durch die Di�erenz der Streuparameter (∆S)
beschreiben:

∆SMagnitude = ||SN | − |SN−1|| (3.1)

∆SPhase = |6 SN − 6 SN−1| (3.2)

Dabei ist:

• |SN | der Betrag der Streuparameter bei der Iteration N ,

• |SN−1| der Betrag der Streuparameter bei der vorherigen Iteration N − 1,

• 6 SN die Phase der Streuparameter bei der Iteration N ,

• 6 SN−1 die Phase der Streuparameter bei der vorherigen Iteration N − 1.

Das Konvergenzkriterium ist erfüllt, wenn sowohl ∆SMagnitude als auch ∆SPhase unter festge-
legten Schwellenwerten bleiben. Dies stellt sicher, dass sowohl die Amplituden- als auch die
Phasenänderungen der Streuparameter zwischen den Iterationen hinreichend gering sind, um
ein zuverlässiges Simulationsergebnis zu erhalten. Inwiefern hierbei Phase und Betrag berück-
sichtigt werden sollen, ist in den Einstellungen zu den Konvergenzkriterien anzupassen. Es
kann entsprechend nur der Betrag oder nur die Phase als Konvergenzkriterium berücksichtigt
werden, wenn dies gewünscht ist.
Neben einer feststellbaren Mindestanzahl an Iterationen, welche eine hohe Au�ösung erzwingt,
gibt es die Möglichkeiten, die maximale Anzahl an Iterationen anzugeben, um eine zu hohe Auf-
lösung zu vermeiden. In folgender Abbildung ist das Konvergenzkriterium auf ein ∆SMagnitude

von 0,01 gestellt worden, um eine hohe Anzahl an Iterationen zu erzwingen. Mit jeder weiteren
Iteration wird die Anzahl der Elemente erhöht und eine feinere Diskretisierung erreicht.

28



3 Simulationssoftware-Einstellungen

0 5 10 15 20
0

0.2

0.4

0.6

0.8

1

Iteration

D
el

ta
M

ag
ni

tu
de

S

Konvergenzverlauf und Elementanzahl über Iterationen

Delta Magnitude S

0

1

2

3

4

5
·104

A
nz

ah
ld

er
El

em
en

te

Elemente

Abbildung 3.11: Entwicklung des Konvergenzverlaufs und der Elementanzahl während des
Prozesses

In der folgenden Tabelle 3.4 ist eine Übersicht über verschiedene Einstellungen mit einer
Beschreibung dieser gezeigt. Hierbei können nicht nur Einstellungen bezüglich des Konver-
genzkriteriums getro�en werden, sondern auch zu Parametern, welche eine Auswirkung auf
die Rechenzeit haben. Auf die Bedeutung des “Frequenzy Modi�ers“ wird in dem Abschnitt
3.4.3 eingegangen.
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Einstellung Beschreibung
Maximum Iterations Bei nicht erreichen der Konvergenztoleranz wird das Re�nement nach

dieser Anzahl beendet.
Minimum Iterations Mindestanzahl an zu durchlaufenden Iterationen, unabhängig des Kon-

vergenzkriteriums.
Minimum Converged Iterati-
ons

Anzahl der zu durchlaufenen Iterationen, bei denen der Fehler bereits
gut angepasst ist.

Frequency Modi�er Standardmäßig löst der Algorithmus einen einzigen Frequenzpunkt
und führt den vollen Sweep in der letzten Iteration durch. Bei ’MID’
wird der mittlere Frequenzpunkt gewählt, ’ALL’ erfasst alle Frequenzen,
’CUSTOM’ ermöglicht eigene Messpunkte.

Result Convergence/Target Steuert, ob bei Erreichen der Konvergenz bei dem Betrag der S-
Parameter oder der Phase und Betrag gestoppt wird.

Result Convergence/Tole-
rance

Das Stopp-Kriterium für das „Ports only“ Mesh verfeinerung. Ein Wert
von 0,01 bedeutet, dass die Lösung weniger als 1% zur vorherigen Itera-
tion abweicht.

Result Convergence/Maxi-
mum Delta Magnitude S

Das Stopp-Kriterium für die Konvergenzänderung des Betrags der S-
Parameter. Ein Wert von 0,01 bedeutet, dass der Betrag weniger als 1%
zur vorherigen Iteration ändert.

Result Convergence/Maxi-
mum Delta Phase S

Das Stopp-Kriterium für die Konvergenzänderung der Phase der S-
Parameter. Ein Wert von 5DEG bedeutet, dass die Lösung weniger als 5
Grad zur vorherigen Iteration konvergiert.

Result Convergence/Ignore
Phase When Magnitude Less
Than

Ab erreichen einer kleineren Konvergenzänderung ist die Phase der
S-Parameter nicht von Belang.

Coarsening Enabled Kontrolliert, ob Größenänderungen an den Elementen während des
AMR vorgenommen werden können.

Target Mesh Growth Fracti-
on

Gibt an, wie schnell das Mesh wachsen darf. Ein Wert von 0,2 gibt 20%
Wachstum verglichen zur vorherigen Iteration vor.

Tabelle 3.4: Übersicht der Konvergenzeinstellungen in AWR Microwave O�ce.

3.4.2 Advanced Mesh Refinement

AWR verfügt über eine fortgeschrittene Mesh-Verfeinerungsfunktion (Advanced Mesh Re�ne-
ment). Diese verfeinert das Mesh, bis das eingestellte Konvergenzkriterium erreicht ist. Um zu
verstehen, welche Auswirkung sich dadurch auf das Simulationsergebnis ergibt, bietet es sich
an, die verschiedenen Phasen des Advanced-Mesh-Re�nements zu erläutern.
Da der Solver Analyst über Waveports verfügt, beinhaltet das Advanced Mesh Re�nement
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einen zusätzlichen vorgeschalteten Prozess. Dieser Prozess diskretisiert die Ports mit einem
Gitternetz. Der Wellenwiderstand dient dabei als Entscheidungskriterium für die Feinheit des
Gitternetzes. Bei diskreten Ports erfolgt eine sofortige Konvergenz und die erste Phase des
Advanced Mesh Re�nements endet nach der ersten Iteration. Falls nach der ersten Iteration
keine zufriedenstellende Konvergenz erreicht wurde, erfolgt eine weitere Verfeinerung des
Gitternetzes, wobei insbesondere kleine Strukturen detaillierter aufgelöst werden[1].
Nach Erreichen des Konvergenzkriterien für die Portlösung, erfolgt die nächste Phase des
Advanced Mesh Re�nements. Eine volumetrische Verfeinerung wird vorgenommen, wodurch
das Gesamtvolumen innerhalb der Simulationsgrenze in einer Gitternetzstruktur aufgelöst
wird. Die Konvergenzkriterien sind hierbei nicht durch Wellenwiderstand gegeben, sondern
über die Parameter der Streumatrix. Die S-Parameter werden hierbei nur für die festgelegte
Frequenz berechnet, um Zeit und Rechenressourcen zu sparen[1].
Neben der Berechnung der Streumatrix wird der nötige Arbeitsspeicher für die nächste Iterati-
on berechnet. Sobald die Rechenressourcen ausgeschöpft sind, wird die nächste Iteration nicht
durchlaufen und eine Berechnung der Streumatrix über alle Frequenzpunkte vorgenommen[1].
Solange die volumetrische Verfeinerung nicht konvergiert ist, kann softwareseitig nicht mit
ausreichender Genauigkeit eine volle Lösung angegeben werden. Komplexe Strukturen sind
eventuell nicht mit der nötigen Feinheit aufgelöst.
In der letzten Phase des Advanced Mesh Re�nements wird die Streumatrix über festgelegten
Frequenzbereich ermittelt. Hier kann vom Benutzer angegeben werden, welche Frequenzen
und mit welchen Sweeptype diese berechnet werden soll. Per Default wird ein Advanced
Frequency Sweep angewandt, welcher nur für gewisse Punkte die Streumatrix berechnet[1].
Die dazwischenliegenden Punkte werden über eine kubische Funktion interpoliert. Dies kann
zur Unterdrückung wichtiger Details im Frequenzgang führen, wodurch Ergebnisse stets genau
zu bewerten sind.
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Abbildung 3.12: Ablauf des Mesh Re�nement Prozesses.

3.4.3 Meshingfrequenz

Die Wahl der Meshingfrequenz spielt eine zentrale Rolle für die Qualität der Simulations-
ergebnisse. Dieses Beispiel, entnommen aus der AWR-Dokumentation, veranschaulicht die
Bedeutung der Meshingfrequenz. Sie de�niert die Frequenz, bei der die Streuparameter für das
Advanced Mesh Re�nement berechnet werden. Ist die Meshingfrequenz nicht optimal gewählt,
beispielsweise im Sperrbereich eines Filters, kann dies zu einer vorzeitigen und unzureichenden
Konvergenz führen, sodass das Gitternetz nicht angemessen an die strukturellen Details der zu
simulierenden Struktur angepasst ist.
In der folgenden Abbildung 3.13 sind die S11-Parameter für einen Bandpass�lter dargestellt.
Die darauf folgenden Abbildungen 3.14 veranschaulichen die resultierenden Gitternetze bei
unterschiedlichen Meshingfrequenzen.
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Abbildung 3.13: Frequenzgang des Bandpass�lters bei verschiedenen Meshingfrequenzen.

(a) Angemessenes Gitternetz bei der Meshfrequenz
von 4,4 GHz. Kritische Bereiche sind fein unter-
teilt.

(b) Unzureichendes Gitternetz bei der Meshingfre-
quenz von 5 GHz.

Abbildung 3.14: Vergleich der Gitternetze bei unterschiedlichen Meshingfrequenzen.

Die Abbildung 3.14a zeigt ein feiner ausgearbeitetes Gitternetz aufgrund mehrerer durch-
laufenen Iterationen. Im Gegensatz dazu zeigt Abbildung 3.14b ein grobes Gitternetz bei der
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Meshingfrequenz von 5 GHz. Die geringere Anzahl an Iterationen resultiert in einer ungenauen
Volumendiskretisierung und kann das Simulationsergebnis verfälschen.

3.5 Solver

Bei der Simulation mit Analyst wird ein Solver verwendet, welcher das Feldproblem mit der
Finite-Elemente-Methode löst. Die Methode der Finiten-Elementen ist eine, mit den Rechenres-
sourcen sparsam umgehender Algorithmus, welcher das Raumvolumen in viele kleine Elemente
unterteilt, die Feldstärke für jede Zelle ermittelt und eine Gesamtlösung darstellt [5]. Die Ver-
feinerung des Gitternetzes ist hierbei eine Methode, um aussagekräftige Simulationsergebnisse
zu erhalten. Dies ist in Kapitel 3.4 erläutert.

Um den Solver an das Feldproblem anzupassen, können über die Optionen der EM Struktur
unter dem Tab Analyst verschiedene Einstellungen vorgenommen werden.

Abbildung 3.15: Einstellungen für den Solver Analyst.

Viele dieser Einstellmöglichkeiten haben einen Ein�uss auf die Analysephase, nachdem die
Simulation abgeschlossen ist, da der Solver über die Genauigkeit auf Basis seiner Einstellungen
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variieren kann. Die Eigenschaften der Ports sind ebenfalls von Interesse, daher �nden sich
separate Einstellmöglichkeiten wieder, welche sich nur auf diese beziehen.
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Einstellung Beschreibung
Field Output Frequency Frequenzen, für welche die Ergebnisse der Simulation gespeichert wer-

den sollen. Wichtige Angabe für Field Annotations, da diese nur, für
entsprechende Frequenzen, verfügbare Datensätze darstellbar sind.

Solve Type FULL kann gewählt werden, um die gesamte Struktur zu simulieren.
Mit der PORTS ONLY Auswahl werden nur die Ports charakterisiert.
Dies ist nützlich, um Charakteristiken des Ports zu erfassen, jedoch
keine zeitintensive volle Lösung zu berechnen.

Sweep Type Auswahl zwischen Automatic, diskret und GAWE. Bei der Auswahl
PORTS ONLY wird immer diskret gesweept. GAWE ist ein schneller
Sweep.

Basis Set Steuert die Shape Funktion zur Interpolation des Feldes in einer Mesh-
zelle.

Minimum Solved Frequency Die niedrigste Frequenz, welche in Analyst mit der FEM gelöst wird.
Darunter hängt das Verhalten des Verfahrens von den Parametern in
Extrapolate Toward DC Einstellungen ab.

Solve Inside Conductors Nützlich, wenn Eindringtiefe bzw. Skin-E�ekt eine Rolle spielen. Es wird
in dem Leiter ein Mesh gezogen, um solche E�ekte in die Gesamtlösung
einzurechnen.

Extrapolate Toward DC Die Einstellung kontrolliert die Lösung des Feldproblems unterhalb
der niedrigsten Frequenz. Es wird der letzte Frequenzpunkt für die
Extrapolation bis DC verwendet. Bei Cubic Polynomial Fit wird eine
kubische Fitfunktion berechnet, um die Punkte zu extrapolieren.

Characteristic Impedance
Method

Dieser Menüpunkt steuert die Methode, mit welcher der Wellenwider-
stand eines Waveports berechnet wird.

Port Solver > Basis Set Steuert die Interpolation des Feldes einer Meshzelle am Port.
Port Solver > Eigensolver >
Method

Der Eigensolver kann eine direkte oder iterative Methode verwenden.
Die direkte Methode sammelt alle Eigenmoden und löst für diese. Die
Iterative wählt mehrere Moden und löst für diese.

Linear Solver > Method FEM benötigt eine Lösung für die Matrixgleichung. Diese Solver sind
lineare Lösungsmethoden. Eine Auswahl als direkte Methode verwendet
eine LU Faktorisierung der Systemmatrix.

Linear Solver > Direct > Me-
thod

Eine der LU Faktorisierungen wird verwendet. MFLU und HMLU. Die
automatische Auswahl entscheidet nach verfügbarer Rechenleistung.

Linear Solver > Direct > HM-
LU > Factor Accuracy Level

Steuert die Genauigkeit der LU-Faktorisierung der Systemmatrix, wel-
che die Anzahl der Iterationen in der Lösung beein�usst.

Remote Simulation for Re�-
ne Solution

Die verfeinerte Lösung kann auf einer anderen Maschine berechnet
werden.

Archive Re�ne Solution Files
to Project

Einstellung über die Archivierung der Ergebnisse nach Berechnung auf
einer anderen Maschine.

Tabelle 3.5: Übersicht der weiteren Simulationseinstellungen in AWR Microwave O�ce.
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Sweep Type

Für den Frequenzdurchlauf gibt es in Analyst eine Auswahlmöglichkeit aus einem diskreten
Frequenzdurchlauf und dem Durchlaufverfahren GAWE, welches für Galerkin Asymptotic
Wave Expansion steht. Sobald der Nutzer hierbei keine der verfügbaren Möglichkeiten durch
eine Auswahl erzwingt, wird das für die Rechenzeit vorteilhaftere Verfahren genutzt. Bei
der diskreten Methode wird für jede zu bestimmende Frequenz ein Finite-Elemente-Problem
gelöst und dargestellt. Bei GAWE werden Frequenzpunkte über eine asymptotische Methode
berechnet, weitere Frequenzpunkte, welche nicht explizit berechnet wurden, werden über Ex-
pansiontechniken approximiert. GAWE eignet sich hierbei speziell für große Frequenzbereiche,
da eine separate Berechnung jedes Punktes zeitintensiv wäre [1].

Basis Set

In AWR werden die Shape-Functions auch Basis-Set genannt. In den Analyst Einstellungen
können diese Basis-Sets angepasst werden, um eine passende Genauigkeit an die Lösung für
das Feldproblem zu approximieren. Hierbei gibt es verschiedene Genauigkeiten, welche durch
eine spezielle Notation ausgedrückt werden. Die Genauigkeit ausgedrückt durch x+1 ist in
Analyst durch hx.5 beschrieben und stellt die grundlegende Genauigkeit in Bezug auf das
elektrische und magnetische Feld dar. Hierbei beschreibt x die Genauigkeit der Interpolation des
Magnetfeldes und x+1 die Interpolation des elektrischen Feldes. Die Interpolation 1. Ordnung
für das elektrische Feld wird somit durch h0.5 dargestellt, welche eine Interpolation 0. Ordnung
für das Magnetfeld vorsieht. Für h1.5 ist die Ordnung der Interpolation des elektrischen Feldes
x+1 also 2. Mit jeder Erhöhung der Ordnung erhält das Basis-Set lineare Funktionen zur
Anpassung an die tetrahedrale Struktur der Meshzelle dazu[1].
Neben einer globalen Einstellung für die Basis-Sets, welche die Felder in einer Meshzelle
interpolieren, stehen weitere Optionen zur Verfügung, welche eine Interpolation höherer
Ordnung in der Nähe von Metallkanten verursachen und in homogeneren Teilen des zu
lösenden Volumens eine geringere Au�ösung der Felder annehmen. Diese Basis-Sets sind in
der Auswahlmöglichkeit mit einem “c“ statt “h“ dargestellt und verwenden bei einer Auswahl
von beispielsweise c2.5 die Basisfunktionen von h2.5 in der Nähe von Metallecken und - kanten.
Von den metallischen Strukturen entfernt wird die Basisfunktion h1.5 angewandt und es endet
mit der Annahme von h0.5 für den Rest des Volumens [1]. Somit werden bei Simulation die
komplexen Strukturen genauer aufgelöst, ohne aufwendigere Berechnungen aufgrund der
global festgelegten Basisfunktion vornehmen zu müssen.
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In der folgenden Tabelle 3.6 sind die verschiedenen anwendbaren Einstellungen für die Basis-
Sets, mit ihrer Ordnung der Interpolation der Felder, dargestellt. Die Anzahl der Funktionen
stellt hierbei die Möglichkeiten der Felddarstellung innerhalb einer Meshzelle dar. So kann
beispielsweise eine Funktion ein konstantes Feld über die Mehszelle darstellen, eine andere
modelliert ein lineares Gefälle in eine bestimmte Richtung. Die Anzahl der Funktionen gib also
die möglichen Feldinterpolationen an.

Notation Elektrisches Feld
(Interpolation)

Magnetisches Feld
(Interpolation)

Anzahl der Funk-
tionen

h0.5 1. Ordnung 0. Ordnung 6
h1.5 2. Ordnung 1. Ordnung 20
h2.5 3. Ordnung 2. Ordnung 45
h3.5 4. Ordnung 3. Ordnung 84
h4.5 5. Ordnung 4. Ordnung 145

Tabelle 3.6: Eigenschaften verschiedener Basis-Sets in Analyst.

Lineare Funktionen der Solver

Die Anwendung der linearen Funktionen �ndet sich in der Lösung des linearen Gleichungssys-
tems wieder, welches für das Feldproblem gelöst werden muss. In Analyst stehen für den direk-
ten linearen Solver zwei LU-Faktorisierungsmethoden bereit. Multi-Frontal LU-Faktorisierung
(MFLU) führt eine exakte Faktorisierung durch, weshalb sie wesentlich genauer als eine hierar-
chische Matrix LU-Faktorisierung (HMLU) ist, welche diese nur approximiert. MFLU erfordert
aufgrund der Genauigkeit mehrere Iterationen und somit mehr Zeit und Rechenressourcen.
HMLU hingegen benötigt weniger Rechenoperationen, kann jedoch aufgrund der Näherung
zu geringerer Genauigkeit führen.
Bei einer LU-Faktorisierung wird eine Matrix als Produkt zweier Matrizen dargestellt. L für
Lower triangular und U für Upper triangular. Bei einem linearen Gleichungssystem wird die
Systemmatrix in die Matrizen L und U zerlegt, um aus diesem System zwei Teilprobleme zu
brechen [7].
Gegeben sei ein lineares Gleichungssystem der Form:

Ax = b (3.3)

wobei A die Systemmatrix, x der Vektor der Unbekannten und b der Quelltermvektor ist.
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Die Matrix A wird in die untere und obere Dreiecksmatrizen L und U zerlegt:

A = LU (3.4)

Zunächst wird das untere Dreieckssystem Ly = b gelöst, um den Vektor y zu �nden:

y = L−1b (3.5)

Anschließend wird das obere Dreieckssystem Ux = y gelöst, um den Vektor x zu �nden:

x = U−1y (3.6)

HMLU und MFLU sind hierbei die numerischen Lösungsverfahren, um das lineare Gleichungs-
system zu lösen.

3.6 Post-processing und Annotationen

Für die Analyse der Simulationsergebnisse werden von AWR Datensätze angelegt, welche
Ergebnisse für Streuparameter und erstellte Annotationen enthalten. Hierbei werden nur für die
Analyse voreingestellter Annotationen die Daten berechnet, um die Simulationsdauer niedrig
zu halten. Über Draw > Add Annotation erscheint eine Auswahl der möglichen Simulationen.
Mögliche Annotationen werden in anliegender Tabelle 3.7 beschrieben.
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Messungsart Messung Beschreibung
Antenne Antenna 3D 3D-Antennenmuster

Antenna CKT 3D 3D-Antennenmuster aus Schaltungserre-
gung

Debug EM EM Deembed Mesh Zeichnet das Mesh des ausgewählten De-
embedding Standards

Spec Mesh Zeichnet die spezi�zierten Facetten
EM3D EM3D Current Ober�ächenströme für 3D EM

EM3D Surf BC Ober�ächengrenzbedingungen für
3D-Modelle

EM3D Surf concerns Gra�sche Marker für potenzielle geometri-
sche Bedenken bei 3D-Modellen

EM3D Surf Ids Ober�ächen-IDs für 3D-Modelle
EM Field Carpet EM-Feld Teppichdiagramm auf der Schnit-

tebene
EM Field Cont EM-Feld Ober�ächenkonturen
EM Field cut EM-Feld auf der Schnittebene
Em �eld vect EM-Feldvektoren
Em Ports �eld Feldmodi der Ports
Mesh 3D Volumetrisches 3D-Mesh
Mesh 3d con Volumetrisches 3D-Mesh
Mesh 3d Surf Begrenzungs�äche für 3D-Mesh

ERC Ext CKT3D Zeichnet Parasitäre in 3D
Ext comp3D Zeichnet spezi�sche Parasitäre in 3D

Planar EM Diagnose Mesh Zeichnet Formen, die Meshing-Fehler ver-
ursachen

Em charge Zeigt die Ladungsdichte des ausgewählten
EM-Dokuments

EM CKT Curr EM-Strom aus Schaltungserregung berech-
net

Em current Zeigt die Ströme des ausgewählten EM-
Dokuments

Em Current SW Zeigt die stehenden Wellenströme des aus-
gewählten EM-Dokuments

EM E Field Zeigt das elektrische Feld an.
Em mesh Zeichnet das Mesh des mit einem bestimm-

ten Port verbundenen Netzes
EM Mesh 2D Zeichnet das Mesh des ausgewählten EM-

Dokuments
HI Aspect Facets Zeichnet nur Facetten mit hohem Seiten-

verhältnis

Tabelle 3.7: Übersicht der verfügbaren Annotationen in AWR Microwave O�ce.
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Für die Annotationen werden zu der Messung passende Einstellungen ermöglicht, indem
beispielsweise die Sweep Frequenz, Polarisation oder die logarithmische Darstellung veränder-
bar sind. Ein Sweep von Standardparametern wie Streuparameter und Wellenwiderstand zur
Evaluierung des Gitternetzes �ndet vor jeder Simulation statt und ist daher ohne Annotation
in den Datensätzen verfügbar. Über Project > Add Graph kann ein beliebiger Graph gewählt
werden und über Project > Add Measurement eine zum Graphen passende Messung eingefügt
werden. Hierbei stehen erneut die bereits angelegten Datensätze zur Verfügung.
In folgender Abbildung ist die Darstellung der S11-Parameter einer Patchantennen gezeigt.
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Abbildung 3.16: S11-Parameter einer Patchantenne für 2,45 GHz.

Nach der erstellten Simulation mit Annotationen können Feldvektoren dargestellt werden.
Eine Animation der Feldvektoren ist mit dem Playbutton in der Werkzeugleiste möglich.
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Abbildung 3.17: Darstellung der Feldvektoren einer Patchantenne in AWR Microwave O�ce.

Insbesondere beim Antennendesign besteht das Interesse, eine Vorabevaluation der Strahlungs-
charakteristik zu machen, bevor diese gefertigt wird. Für dieses Interesse stehen Antennenplots
zur Verfügung, welche die Strahlungscharakteristik in einem Polargraphen aufzeigen. Im
folgenden Beispiel ist die Charakteristik der Patchantenne abgebildet, welche über Theta
gesweept wurde.
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Abbildung 3.18: Darstellung der Strahlungscharakteristik der Patchantenne in AWR Microwave
O�ce.
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4 Technische Umsetzung und Simulation

In diesem Kapitel wird eine beispielhafte Anwendung von Analyst in der Simulationssoftware
AWR Microwave O�ce gezeigt. Es wird in der Simulationsumgebung die EM Struktur einer
Patchantenne erstellt, simuliert und im post-processing ausgewertet. Wobei vorgestellte Mög-
lichkeiten und Einstellungen, welche Analyst bietet, zur Anwendung kommen. Diese können
einen praktischen Bezug zu erläuterter Theorie bilden.

Theoretische Auslegung

Als Beispiel soll eine Patchantenne verwendet werden, welche eine Resonanz bei 2.45 GHz
aufweist. Als Substrat wird das Material RO4350B mit einer Dieleketrizitätskonstante von 3.47
und einer Dicke von 0.76 mm verwendet. Außerdem ist beidseitig eine Kupferschicht mit einer
Dicke von 0.035 mm aufgelegt.
In folgender Abbildung 4.1 ist eine technische Zeichnung der Patchantenne dargestellt.

Abbildung 4.1: Technische Zeichnung für die Patchantenne.

Die Parameter der Patchantenne sind abhängig von der Frequenz sowie von der Substratdicke
und der Dielektrizitätskonstante. Bei einer Antenne auf einer Platine spielt die e�ektive Di-
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elektrizitätskonstante eine wichtige Rolle, da sie von der Angabe aus Datenblättern abweicht.
Diese lässt sich nach der Formel

εe� =
εr + 1

2
+
εr − 1

2

(
1√

1 + 12(h/W )

)
(4.1)

bestimmen, wobei εr die Dielektrizitätskonstante des Substrats, h die Höhe und W die Breite
des Substrats sind [8].
Die Breite des Patchelements kann mit der Ausbreitungsgeschwindigkeit v und der e�ektiven
Dielektrizitätskonstanten berechnet werden [8]:

W =
v

2f0

√(
εr+1
2

) (4.2)

Die Länge des Patchelements hängt von der Breite und der Höhe des Dielektrikums ab [8]:

L =
c

2f0
√
εe�
− 0, 823h

(
(εe� + 0, 3)(W/h+ 0, 264)

(εe� − 0, 258)(W/h+ 0, 8)

)
(4.3)

Die Impedanz der Antenne kann über das Verhältnis von Länge zu Breite bestimmt werden [8]:

Zin = 90

(
ε2r

εr − 1

)(
L

W

)2

(4.4)

Die Bandbreite der Antenne ergibt sich aus[8]:

B = 3, 77f0

(
ε2r

εr − 1

)(
Wh

Lλ

)
(4.5)

Um die Antenne in ihrer Frequenz impedanzmäßig anzupassen, wird folgende Näherungsformel
verwendet [8]:

D =
L

π
cos−1

(
4

√
Zfeed

ZAntenna

)
(4.6)

wobei D die Tiefe darstellt, bis zu welchem Punkt die Zuführung in das Patchelement hinein-
geht.
Für eine optimale Anpassung sind oft weitere Abstimmungen notwendig.
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Design der Patchantenne in AWR Microwave O�ice

Der Designprozess startet mit dem Erstellen einer neuen EM Struktur. Dies erfolgt über
Rechtsklick auf EM Structure > New EM Structure in dem Projektfenster. Anschließend
ö�net sich ein Fenster, in welchem die Auswahl des Solvers geschieht. Als Solver wird der Finite
Elemente Solver Analyst ausgewählt, welcher auch in der Beschreibung für volumetrische
Feldprobleme ausgewiesen ist. Der Frequenzbereich für welchen simuliert werden soll, kann
in den Projektoptionen über den Pfad Options > Project Options > Frequencies festgelegt
werden. Als nächster Schritt werden die Optionen für die EM-Struktur festgelegt. Diese bein-
halten Materialien, Boundaries und dielektrische Lagen und können über “Enclosure“ bei der
im Projekt erstellten EM-Struktur ausgewählt werden.

Abbildung 4.2: Einstellungen der Enclosure in Rot markiert. Mit dem Menü zur Anpassung
verfügbarer Materialien.

Unter dem Reiter ‘“Material De�nitions“ wird das Material RO4350B als Dielektrikum mit
einem εr von 3,47 und einem tan δ von 0.0057 erstellt. Dadurch können in der Designumgebung
eingefügte Strukturen dieses Material zugewiesen bekommen.
In dem nebenstehenden Reiter “Boundary Conditions“ werden die Eigenschaften der Grenzbe-
dingung festgelegt. Bei dem Aufbau einer Antenne emp�ehlt sich die Perfectly Matched Layer,
aufgrund ihres Wellenwiderstandes von 377 Ω. Dies muss für alle Seiten der Simulationsgrenze
erfolgen. Eine Grenzbedingung wird also nicht automatisch für alle Seiten angenommen.
Aufgrund des Lagenaufbaus in AWR müssen die verschiedenen Schichten de�niert werden. Der
Reiter dazu heißt “Dielectric Layers“ und ermöglicht über “Insert“ und “Delete“ ein Zufügen
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und Entfernen dieser. In diesem Beispiel sind drei Lagen ausreichend. Die mittig angeordnete
Lage hat hierbei die Dicke des Substrats der Platine mit 0,76 mm und die anderen Lagen stellen
den Abstand zur oberen und unteren Simulationsgrenze ein, hierbei mit 10 mm Abstand. Alle
Lagen bekommen das Material Luft zugewiesen. Eine Zuweisung als Material in diesem Fenster
hat zur Folge, dass die gesamte Lage als dieses angenommen wird und somit kein Abstand zur
Simulationsgrenze gescha�en wird. Dadurch würde die Antenne verstimmt werden und die
Simulationsergebnisse verlieren an Zuverlässigkeit.
In dem Reiter “Materials“ können nun die zuvor de�nierten Materialien in ihrer Dimension
beschrieben werden. Nur, wenn hier de�niert, werden sie später als Material zur Verfügung
stehen. In diesem Fall wurde das Trace 1 mit einer negativen Dimension formuliert, also mit
einem Minuszeichen vorstehend, um zu ermöglichen, die Leiterbahn unterhalb der Layer 3 zu
führen. Außerdem muss das zuvor de�nierte Dielektrikum zu den Materialien hinzugefügt
werden.
In Abbildung 4.3 ist die Position der Leiterbahn mit einer negativen Dimension erläutert. Bei
einer positiven Dicke würde dieses Material auf der Schicht liegen und somit im Dielektrikum
sein.

Abbildung 4.3: Positionierung des Materials mit einer negativen Dicke. Das Material verläuft
unter der zugewiesenen Schicht.

Automatisch ist nach Anlegen einer neuen Struktur eine Grenzbedingung gesetzt, welche als
gestrichelter Kasten in der Arbeits�äche sichtbar ist. Diese kann zunächst durch Linksklick
ausgewählt und gelöscht werden, da dieser, nachdem die Antenne fertig erstellt ist, zugefügt
wird.
Zum Zeichnen der Strukturen, benötigt die Software eine Angabe, auf welcher Schicht diese
Strukturen platziert werden sollen. Andernfalls wird die Option zum Zeichnen nicht zur
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Verfügung stehen. Daher wird von dem Projektfenster, durch Anwählen des Reiters “Layout“,
auf dieses gewechselt und eine entsprechende Zeichenschicht gewählt.
Nachdem allgemeinere Einstellungen bezüglich des Projekts festgelegt und gespeichert sind,
kann über Draw > Rectangle das Patchelement gezeichnet werden. Während das Rechteck
gehalten wird, kann mit der Tabulatortaste ein Fenster geö�net werden, welches eine Eingabe
der Maße ermöglicht.

Abbildung 4.4: Fenster zur Eingabe der Koordinaten für eine erstellte Struktur nach Verwen-
dung der Tabulatortaste.

Nachdem das Element gezeichnet wurde, wird es per Default auf die zuvor gewählte Zeichen-
schicht gelegt. Daher muss eine neu gezeichnete Struktur eventuell über Rechtsklick auf das
Element > Shape Properties angepasst werden. Auch das entsprechende Material, welches
verwendet werden soll, sollte überprüft werden. Für den Microstrip, welcher als Zuleitung
dient, kann die Dimension über Tools > TXLine bestimmt werden. Dazu muss die passende
Frequenz und das entsprechende Material ausgewählt sein. Wenn bei der Impedanz 50 Ω
angegeben ist, wird die Dimensionierung für eine auf die entsprechende Impedanz angepasste
Leitung ausgegeben.

Abbildung 4.5: Eingebettetes Tool “TXLine“ zur Berechnung von Streifenleitungen.
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Wie zuvor wird ein Rechteck gemalt, welches über TAB die aus TXLine ermittelten Dimen-
sionen erhält. Da noch Schlitze eingefügt werden müssen, wird hier der Microstrip zunächst
nebengelegt.

Abbildung 4.6: Erstellung des in TXLine berechneten Streifenleiter mit hilfe der Größenangabe
im Koordinatenfenster.

Es kann erneut ein Rechteck gemalt werden, welches die Schlitze mit hilfe der Logikfunktionen
einbringt. Dazu eignet sich besonders ein „Exclusiv or“, jedoch reduziert auch „substract“ um
die entsprechende Dimension.
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Abbildung 4.7: Erstellung der Aussparung für das Patchelement der Antenne mit hilfe der
Größnenangabe im Koordinatenfenster.

Um nun diese Fläche von dem Patchelement abzuziehen, wird wie folgt vorgegangen:

1. An die richtige Position legen Linksklick auf das Patchelement > Shift + Linksklick
auf das abzuziehende Element > Draw > Align Shapes > Center danach erneut
Draw > Align Shapes > Bottom

2. Abziehen des Elements Draw > Modify Shapes > Substract

Nachdem der Ausschnitt für die dielektrische und leitende Schicht geschehen ist, kann auch
der angepasste Microstrip hinzugefügt werden. Über die Tiefe und Breite des Schlitzes wird das
Patch Element in der Impedanz eingestellt. Ein Doppelklick auf die Struktur lässt Gri�punkte
erscheinen, mit welcher die Breite angepasst werden kann. Dies wird im späteren Verlauf
wichtig, um die Struktur im Frequenzgang anzupassen.
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Abbildung 4.8: Fertiges Patchelement in angewählter Ansicht. Blaue Punkte dienen als Gri�-
punkte zum manuellen verstellen der Kanten.

Über Linksklick auf das Patchelement > Align Shapes > Center wird der Microstrip mittig
ausgerichtet. Er muss manuell in der vertikalen Position verschoben werden, sodass dieser
korrekt platziert ist.

Abbildung 4.9: Fertige Patchantenne jedoch ohne Dielektrikum und Groundplane.

Zum Hinzufügen von Ground muss lediglich ein großes Rechteck gezeichnet werden und
dieses auf die korrekte Schicht mit Trace 1 gelegt werden. Hierbei macht sich die negative
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Dimensionierung bezahlt. Als Dimension für Ground wird in diesem Beispiel (60 mm x 80 mm)
angenommen und es wird auf Schicht 3 gelegt.

Abbildung 4.10: Propertie eines Elements. Schicht und Material sind neben der Auswahl als
Via oder Conductor auswählbar.

Es muss zum De�nieren der Ports die Zuführung exakt mit der Ground-Layer übereinander
liegen. Dazu sind die Align-Funktionen erneut hilfreich. Eine Zuweisung der Ports erfolgt
im späteren. Linksklick auf den Microstrip > Shift + Linksklick auf die Groundplane
> Draw > Align Shapes > Center, danach erneut auf Draw > Align Shapes > Bottom.

Abbildung 4.11: Fertige Patchantenne mit Groundplane ohne Dielektrikum.

Zuletzt wird das Substrat zugefügt. Da dieses die gleiche Dimensionierung wie Ground haben
soll, kann das zuvor erstellte Rechteck mit Strg+C und Strg+V kopiert werden. Lediglich in
den Shape properties müssen Umstellungen erfolgen.
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Abbildung 4.12: Eigenschaften des Dielektrikums. Es liegt auf Schicht 3 und ist als Conductor
angelegt.

Um nicht in den unendlich großen Raum zu simulieren, muss eine Boundary festgelegt werden.
Dazu wird erneut ein Rechteck mit weitem Abstand von der Antenne de�niert. Wenn das neu
erstellte Rechteck ausgewählt ist, wird über Draw > Create 3D EM Simulation Boundary
dieses als die Grenzbedingung für die Simulation festgelegt.

Abbildung 4.13: Arbeitsober�äche in AWR Microwave O�ce während der Erstellung einer
Simulationsgrenze. Der gelben Kasten ist ausgewählt und wird in dem Menü
“Draw“ als Boundary festgelegt.

Über Draw > Add Edge Port wird ein Port angewählt und muss an die Zuführung gelegt
werden.
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Abbildung 4.14: Port angelegt an den unteren Teil des Streifenleiters.

Abbildung 4.15: Für den Port wurde “Lumped Down“ ausgewählt. Er ist nach unten zu Ground
verbunden.

Das 3D-Modell lässt sich ebenfalls betrachten. Eine Kontrolle ist hilfreich, um zu beobachten,
ob ein Layer falsch de�niert wurde oder ein Material falsch zugewiesen ist.
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Abbildung 4.16: Fertige Patchantenne mit Groundplane, Dielektrikum und Port in der 3D-
Ansicht.

Post-processing

Rechtsklick auf Graph > New Graph ö�net viele Möglichkeiten wie Rectangel oder Smith.
Nachdem eines davon ausgewählt wurde, kann über einen erneuten Rechtsklick in den Graphen
eine neue Messung hinzugefügt werden. Interessant um zu schauen, ob die Antenne angepasst
ist, sind die S11-Parameter.
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Abbildung 4.17: Erstellung eines neuen Graphen über einen Rechtsklick auf den Ordner “Gra-
phs“.

Abbildung 4.18: Anlegen einer neuen Messung über einen Rechtsklick in das Koordinatensys-
tem.
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Abbildung 4.19: Darstellung der S11-Parameter der Patchantenne in dB. Die Optik aus AWR
Microwave O�ce wurde hierbei beibehalten, um einen Eindruck zu verschaf-
fen.

Auch die Strahlungscharakteristik kann mit hilfe eines “Antennaplots“ dargestellt werden.
Hierzu gilt es zu beachten, dass die Struktur erst simuliert werden muss und anschließend der
Graph unter Berücksichtigung des Sweeps “FSAMP“ als Measurement beigefügt werden kann.
Rechtsklick Graphs > New Graph > Antenna Plot > New Measurement > PPC-TPwr

Abbildung 4.20: Polargraph, welcher die Strahlungscharakteristik der Patchantenne darstellt.

Besonders interessant ist jedoch das Zufügen von Annotations, um beispielsweise die Feldvek-
toren zu betrachten. Eine Annotation für die Feldvektoren kann über Rechtsklick auf die
EM-Struktur > Add Anotation > EM 3D > EM-FIELD-VEC angelegt werden. Sollte es eine
Fehlermeldung geben, da keine Daten vorliegen, muss die Struktur erneut simuliert werden,
mit Rechtsklick auf die EM-Struktur > Force Re-Simulation
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Abbildung 4.21: Darstellung der Feldvektoren nach Simulation mit der Annotation “EM-FIELD-
VEC“.
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5 Bewertung

In diesem Abschnitt wird beschrieben, wie weitere Einstellungen sich auf die Simulationsergeb-
nisse auswirken. Neben dem Vergleich, von dem Simulationsergebnis der EM Struktur und dem
physischen Nachbau der Patchantenne, erfolgt eine Analyse der Auswirkung verschiedener
Sweepmethoden und der Basisfunktionen.

5.1 Unterschied Sweepmethoden

In dem Abschnitt3.5 ist eine Auswahl aus den Sweepmethoden “Auto“ und “Galerkin Asym-
ptotic Wave Expansion (GAWE)“ beschrieben. Um Unterschiede dieser zu untersuchen, wurde
eine Simulation mit beiden Auswahlmöglichkeiten durchgeführt und festgestellt, dass Abwei-
chungen gering sind. Im Gegensatz zu der normalen Sweepmethode konnte jedoch mit der
Methode nach GAWE eine Simulationsdauer von 1.49 Minuten erreicht werden, während der
diskrete Sweep eine Dauer von 5.28 Minuten benötigte.
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Abbildung 5.1: Frequenzgang des Bandpass�lters mit Sweepmethode GAWE und Auto. Es ist
kein Unterschied erkennbar.

Die folgende Tabelle ist aus den Simulationslogs erstellt worden und zeigt sowohl Unterschiede
in der Simulationszeit als auch die Anzahl der Matrixlösungen.

Sweep-Type AMR-Zeit (min) Gesamtzeit (min) Matrixlösungen (MFLU)
GAWE 0.95 1.37 70
Diskret 1.08 5.28 274

Tabelle 5.1: Vergleich von GAWE und diskreter Sweepmethode

Aus den Simulationslogs geht hervor, dass der diskrete Sweep einen erheblichen Mehraufwand
in dem Lösen der Matrixgleichungen betreibt. Für Strukturen, wie Streifen�lter, ist die Me-
thode nach Galerkin ausreichend und zeitsparend. Diese Methode kann jedoch aufgrund der
eingesparten Matrixlösungen Details in der Berechnung komplexerer Strukturen verlieren.

5.2 Unterschiede Basis Funktionen

In dem Kapitel 3.5 wurden die Basisfunktionen erläutert, welche dazu dienen, eine Inter-
polation der Felder in einer Meshzelle zu scha�en und diese mit hilfe linearer Funktionen
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darstellbar zu machen. Hierzu stellt AWR Microwave O�ce verschiedene Möglichkeiten mit
unterschiedlichen Interpolationsgraden zur Verfügung. Diese unterscheiden sich, wie in Tabelle
5.2 aufgezeigt, in ihrer Simulationszeit und dem Bedarf an Rechenressourcen. Aufgrund ihrer
Relevanz und dem direkten Eingri� in die Methode der �niten Elemente unterscheiden sich
Simulationsergebnisse wie in Gra�k5.2 dargestellt.

3.8 4 4.2 4.4 4.6 4.8 5

−30

−20

−10

0

Frequenz (GHz)

S1
1

Pa
ra

m
et

er
(d

B)

Frequenzgang eines Bandpass�lters mit verschiedenen Basisfunktionen

h4.5
h3.5
h2.5
h1.5
h0.5

Abbildung 5.2: S11 Parameter (dB) eines Bandpass�lters für verschiedene Basisfunktionen

Der entstandene Speicherbedarf der verschiedenen Basisfunktionen ist zusammen mit der
Simulationsdauer in Tabelle 5.2 eingetragen. Hier ist sichtbar, dass sich der wachsende Interpo-
lationsgrad, bedingt durch die Wahl der Basisfunktion, unmittelbar auf Speicherbedarf und
Simulationsdauer auswirkt. Mit dem Basis Set, welches den höchsten Interpolationsgrad bietet,
wurde eine Simulationsdauer von 26.45 Minuten erreicht und nahezu 20 GB an Arbeitsspeicher
benötigt. Eine akkurate Berechnung der Struktur konnte mit der niedrigsten Einstellung hierbei
nicht erreicht werden.
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5 Bewertung

Basisfunktion RAM (MB) Anzahl der
Meshzellen

Matrix Fak-
tor (MFLU)

Matrix
Lösungen
(MFLU)

Dauer (min)

h0.5 545.0 3450 8 48 0.12
h1.5 5242.8 19968 19 70 1.23
h2.5 17474.7 15719 14 60 4.46
h3.5 21236.4 9453 9 50 11.17
h4.5 20293.8 7022 6 44 26.45

Tabelle 5.2: Vergleich der Simulationsergebnisse für verschiedene Basis Sets

Um detailreiche Strukturen ohne zu hohen Rechenaufwand aufzulösen oder die Felder in
Meshzellen nahe an Metallkanten mit einem hohen Interpolationsgrad zu berechnen, gibt es die
Möglichkeit adaptive Basisfunktionen zu verwenden. Die Simulationsergebnisse sind in Tabelle
5.3 festgehalten. Hierbei konnte in 6.71 Minuten ein Ergebnis erreicht werden, welches sich, wie
in Abbildung 5.3 gezeigt, geringfügig von der fest eingestellten Basisfunktion unterscheidet.
In diesem Simulationsbeispiel konnte die E�zienz durch Anpassung der Basisfunktionen
erheblich verbessert werden.

Basisfunktion RAM (MB) Anzahl der
Meshzellen

Matrix Fak-
tor (MFLU)

Matrix
Lösungen
(MFLU)

Dauer (min)

c1.5 3683.2 66672 28 88 2.74
c2.5 4467.0 13517 16 64 0.92
c3.5 15152.5 10527 13 58 6.57
c4.5 13774.0 4206 8 48 6.71

Tabelle 5.3: Vergleich der Simulationsergebnisse für verschiedene adaptive Basis Sets
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Abbildung 5.3: Vergleich der Simulationsergebnisse mit Verwendung der Basisfunktion, welche
die höchste Interpolationsstufe bieten.
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Abbildung 5.4: Darstellung des Deltas zwischen den Werten der adaptiven Basisfunktion c4.5
und der feststehenden Basisfunktion h4.5.

5.3 Vergleich der Patchantenne mit physischem Nachbau

Die im Kapitel 4 entworfene Patchantenne, wurde für eine Validierung der Simulationsge-
nauigkeit von AWR Microwave O�ce, mit dem Solver Analyst physisch nachgebaut und
ihre Streumatrix für einen Vergleich vermessen. Der Nachbau dieser ist in der Abbildung 5.5
dargestellt. Die Antenne wurde hierbei ebenfalls in einer Antennenmesskammer vermessen,
um die Strahlungscharakteristik zu erfassen.
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5 Bewertung

(a) Frontansicht der gefertigten Patchantenne. (b) Rückansicht der gefertigten Patchantenne.

Abbildung 5.5: Vor- und Rückseite der gefertigten Patchantenne

Abbildung 5.6 zeigt hierbei einen sehr ähnlichen Verlauf der S11 Parameter, wie die Simulation
es berechnet hat. Als Mittenfrequenz sollte bei der Auslegung 2.45 GHz getro�en werden.
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Abbildung 5.6: Graphen der simulierten und nachgebauten Patchantenne.
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Größere Unterschiede ergeben sich für die Strahlungscharakteristik. Dargestellt in Abbildung
5.7 ist eine Hauptkeule, welche vom Patchelement wegstrahlt.

Abbildung 5.7: Strahlungscharakteristik der Patchantenne bei 2.45 GHz in der Simulationsum-
gebung.

In Abbildung 5.8 ist die Messung der Strahlungscharakteristik aus der Antennenmesskammer
festgehalten. Eine geringe Abstrahlung gegen die Ausrichtung der Patchantenne konnte hierbei
korrekt simuliert werden. Auch eine nach vorn gerichtete Hauptkeule entspricht der Erwartung,
welche aus der Simulation hervorgeht.
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5 Bewertung

Abbildung 5.8: Strahlungscharakteristik des Nachbaus der Patchantenne bei 2.45 GHz in der
Antennenmesskammer bei vertikaler Polarisation.
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6 Schlussfolgerung mit Ausblick

In dieser Arbeit werden Aspekte der Hochfrequenzsoftware AWR Microwave O�ce beleuchtet,
welche dem Nutzer zur Verfügung stehen, um die Feldsimulation an das entsprechende Problem
anzupassen. Dabei werden Eigenheiten, wie der Lagenaufbau und das Arbeiten im 2D-Editor,
kenntlich gemacht. Auch erweiterte Möglichkeiten, wie der 3D-Editor zur Erstellung volume-
trischer Strukturen, werden erwähnt. Es sind dem Anwender viele Möglichkeiten bezüglich
der Kon�guration wichtiger Elemente in der Simulation von Feldproblemen geboten, wodurch
dieser mit den entsprechenden Freiheitsgraden umgehen muss. Die verfügbaren Optionen
und die Auswirkung werden in Kapitel 3 oder 5 erklärt. Angefangen mit dem Anlegen von
Materialien und die Erstellung dieser in Abschnitt 3.1, sind erste Arbeitsweisen mit AWR
Microwave O�ce erläutert. Hierbei ist ein Augenmerk auf den Schichtenaufbau zu legen,
da bei der Dimensionierung der Materialdicke eine negative Dimensionierung Vorteile im
späteren Aufbau bringen kann. Die Möglichkeit bezüglich Ports sind in Kapitel 3.2 erläutert.
Auch hier gibt es eine vielfältige Auswahl, welche durch di�erentielle Ports, Waveports und
Funktionen wie de-embedding gefüllt ist. Auch Ports, welche sich nach Ground verbinden und
an Kanten oder Zentren von Strukturen gelegt werden können, fehlen hier nicht. Über die
Einstellungen der Boundaries in Kapitel 3.3 können die Grenzbedingungen festgelegt werden,
welche neben in Simulationssoftware gängigen Optionen auch die “Perfectly Matched Layer“
mit einem Wellenwiderstand von 377 Ω anbietet. Die Eigenschaften dieser Grenzbedingun-
gen werden in Tabelle 3.2 mit ihren Nutzungshinweisen dargestellt. Da die Entwicklung des
Gitternetzes einer der kritischsten Vorgänge in einer Simulation für Feldprobleme ist, wird
in Abschnitt 3.4 auf diese eingegangen. Neben der Erläuterung von Konvergenzkriterien und
adaptiven Algorithmen zur Bildung des Gitternetzes, ist in Tabelle 3.3 eine Reihe an möglichen
Einstellungen aufgezeigt, welche den Meshingprozess beein�ussen und dabei helfen können,
das Gitternetz dem zu berechnenden Problem anzupassen. Eine wichtige Rolle hierbei stellt die
Meshingfrequenz, welche, wie in Abbildung 3.13 sichtbar, bei falscher Anwendung zu fehlerhaf-
ten Simulationsergebnissen führen kann. Der Solver kann mit den Einstellungen aus Tabelle 3.5
angepasst werden. Neben Aspekten wie der Sweepmethode und den Shape-functions, welche
in AWR als Basis Set bekannt sind, wird auf die LU-Faktorisierung eingegangen, um ihre Wich-
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6 Schlussfolgerung mit Ausblick

tigkeit im Lösungsalgorithmus zu verdeutlichen. Durch Post-processing und Annotationen
können, wie in Kapitel 3.6 beschrieben, Felddarstellungen ermöglicht werden. Hierbei sind in
Tabelle 3.7 alle in AWR Microwave O�ce verfügbaren Darstellungsmöglichkeiten aufgezeigt,
welche jedoch nur in Abhängigkeit des Solvers zur Verfügung stehen. Um Rechenressourcen
zu sparen, werden die in den Annotationen gezeigten Möglichkeiten nur berechnet, wenn
diese vom Anwender aktiviert werden. Um einen praktischen Bezug zu scha�en, behandelt
der Abschnitt 4 den Designprozess einer Patchantenne für eine Frequenz von 2.45 GHz. Diese
wird im Anschluss simuliert und ist ebenfalls Gegenstand der Auswertung in Kapitel 5.3.

Durch ein praktisches Beispiel wird gezeigt, dass AWR Microwave O�ce ein professionelles
Softwaretool ist, welches in einer Simulation die Sachverhalte der Realität widerspiegeln kann.
Auch, wenn aufgrund der vielfältigen Möglichkeiten die Einarbeitung anfangs schwerer vor-
kommt, als es bei intuitiveren Umgebungen wie CST Studio Suite der Fall ist, adaptiert man
schnell an die ungewohnte Umgebung und erlangt eine e�ziente Arbeitsweise im Umgang mit
Feldproblemen und der Modellierung komplexerer Strukturen. Eine intuitivere Bedienober�ä-
che oder sogar ein Ersetzen des 2D-Editors durch eine CAD-Umgebung könnte hierbei helfen,
Anwender an sich zu binden und von den Stärken dieser Software zu überzeugen. Ein weiteres
spannendes Gebiet könnte die Optimierung von Algorithmen für die Bildung der Gitternetze
sein, insbesondere im Hinblick auf die Automatisierung und KI-gestützte Anpassungen. Als
Gesamteindruck bleibt ein Softwaretool, welches viele Bereiche der Elektrotechnik abdeckt
und durch Implementation vieler Teilalgorithmen dem Nutzer die Möglichkeit überlässt, die
Simulationseinstellungen des Bedarfs anzupassen.
AWR Microwave O�ce ist ein Softwaretool, welches für die Simulation und Erstellung von
Strukturen neben anderen Softwaretools zielführend verwendet werden kann. Durch etliche
Freiheitsgrade in den Einstellungen und den direkten Ein�uss auf Lösungsalgorithmen bie-
tet die Software den Anspruch professionell genutzt zu werden und belohnt mit akkuraten
Simulationsergebnissen.
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Anhang

Der weitere Anhang be�ndet sich auf CD und kann beim Erstgutachter eingesehen werden.

71



Eigenständigkeitserklärung

Hiermit versichere ich, dass ich die vorliegende Arbeit ohne fremde Hilfe selbständig verfasst und

nur die angegebenen Hilfsmittel benutzt habe.

Hamburg, 11.04.2024 Niklas Neujahr


	Tabellenverzeichnis
	Abbildungsverzeichnis
	1 Einführung
	1.1 Definitionen
	1.2 Einleitung in das Thema
	1.3 Ziele und Fragestellung der Arbeit

	2 Theoretischer Hintergrund
	2.1 Berechnung von Feldproblemen in Software
	2.2 Finite-Elemente-Methode
	2.3 Vorstellung der Simulationssoftware AWR

	3 Simulationssoftware-Einstellungen
	3.1 Materialien
	3.2 Ports
	3.3 Boundaries
	3.4 Meshing und Konvergenz
	3.4.1 Konvergenzkriterien
	3.4.2 Advanced Mesh Refinement
	3.4.3 Meshingfrequenz

	3.5 Solver
	3.6 Post-processing und Annotationen

	4 Technische Umsetzung und Simulation
	5 Bewertung
	5.1 Unterschied Sweepmethoden
	5.2 Unterschiede Basis Funktionen
	5.3 Vergleich der Patchantenne mit physischem Nachbau

	6 Schlussfolgerung mit Ausblick
	Literaturverzeichnis
	Anhang
	Anhang

